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Welcome to SpeechExec 

Welcome to SpeechExec Pro Transcribe Online Help.  

SpeechExec has been developed for the professional dictation and transcription business. It provides all the 
advantages of digital dictation combined with sophisticated file management capabilities. 

SpeechExec comes as a complete dictation and transcription solution. The product is highly modular and can 
thus fulfill the business requirements from small offices to large companies and is suitable for any volume of 
document creation. SpeechExec can be used together with various Philips hardware devices such as the 
SpeechMike, the DPM or the Foot Control. It is the perfect solution for any dictation and transcription needs 
where all components can be obtained from one manufacturer. 

Complete digital dictation and transcription workflow. • 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Intuitive and easy-to-use user interface with fast access to all major functions. 

Advanced sound file editing functions. 

Support for various Philips hardware devices. 

Support for different sound file formats including WAV, DSS, MP3 and WMA. 

Configurable function keys. 

Recording of special instructions and spoken instructions. 

Sophisticated email and FTP delivery. 

Various configuration tools. 

Highly customizable to provide optimum support for users in their everyday work. 

Note: The screenshots in this Online Help have been taken from the Windows XP operating system. The user 
interface elements (e.g. dialog boxes, button names, etc.) may be slightly different in other operating systems. 

SpeechExec modules 

SpeechExec has the following modules:  

SpeechExec Pro Dictate 
This module enables authors to work with dictation files, manage their worklist and tree view, define dictation and 
folder properties, configure their DPM, download DPM files, send dictations by email and make various settings 
for recording dictations. 

The SpeechExec Pro Dictate module cannot run in parallel with the SpeechExec Pro Transcribe module. 

SpeechExec Pro Transcribe 
This module enables transcriptionists to work with dictation files, manage their worklist and tree view, define folder 
properties, download DPM files, receive dictations by email and make various settings for transcribing dictations. 

The SpeechExec Pro Transcribe module cannot run in parallel with the SpeechExec Pro Dictate module. 

SpeechExec Recorder 
This module enables authors to perform the dictation tasks such as recording, recording of special and spoken 
instructions, playback, editing and positioning in the sound file. They can also edit dictation properties and make 
various settings. 

SpeechExec Player 
This module enables transcriptionists to perform tasks such as playback, playback of special and spoken 
instructions, positioning in the sound file. They can also view dictation properties and make various settings. 
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Trademarks 

SpeechExec™, SpeechMike™ and Pocket Memo® are trademarks of Koninklijke Philips Electronics N.V.  

Trademarks of other companies 
Windows 2000, Windows XP Microsoft Corporation 

Pentium Intel Corporation 

All other names are trademarks, registered trademarks or service marks of their respective owner.  

System requirements 

The SpeechExec Pro Dictate module requires the following hardware and software specifications in order to 
function properly:   

Hardware requirements 
The minimum requirement for your processor is: Pentium II with 233 MHz and 64 MB RAM.  • 

• 

• 

• 

• 

• 

• 

The recommended requirement for your processor is: Pentium III with 500 MHz and 128 MB RAM.  

30 MB hard disk space is required. 

Microsoft .NET 1.1 Framework requires 150 MB of free disk space for installation and 110 MB for runtime. 

A Philips Sound Blaster or compatible sound card is needed if no SpeechMike USB or USB Adapter Box 
(6220) is used. 

A self-powered USB port for SpeechMike USB. 

Software requirements 
For all operating systems listed below, we recommend that you apply the latest Service Pack available before 
installing SpeechExec. 

Microsoft Windows 2000 

Note: For DPM make sure you have Service Pack 3 applied. 

Microsoft Windows XP (Home or Professional edition) 
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Introduction 

Introduction - overview 

This section provides an introduction to some basic concepts of SpeechExec. Use the links below to access the 
individual Help topics.  

Licensing and dongle • 

• 

• 

• 

• 

• 

Phases and states 

Folder types 

Local Work folder 

Instructions 

Archive, backup and purge 

Licensing and dongle 

SpeechExec supports a workstation-based licensing scheme which includes the SpeechExec components listed 
below: SpeechExec supports workstation-based and site-based licensing schemes. Both licensing schemes 
include the SpeechExec components listed below. For more information about the site-based licensing scheme, 
see: Site license.  

SpeechExec Pro Dictate - The dictation solution with advanced recording functions for the professional 
author. The integrated Worklist module provides sophisticated file management capabilities. 

• 

• 

• 

• 

• 

• 

• 

• 

SpeechExec Pro Transcribe - The professional transcription solution. The integrated Worklist module 
perfectly complements the dictation workflow. 

Note: The same user cannot start SpeechExec Pro Dictate and SpeechExec Pro Transcribe in parallel on the 
same PC. If a program is already running a corresponding error message box is displayed. 

SpeechExec SDK - The powerful SDK for developing intelligent dictation and transcription applications. 

Trial version 
The trial version enables you to explore the capabilities of SpeechExec. It provides you with a basic evaluation of 
our technology, however it is not fully functional and is designed to provide you with only a quick overview of the 
SpeechExec environment. It is functionally limited in the following areas: 

The trial version can be used for a 30-day evaluation period without a dongle. During that period, every time 
the program is started a message is displayed with information about the number of days left for evaluation. 
When the evaluation period is over a message is displayed which informs you that the evaluation period has 
expired and provides you with details of where to purchase a fully functional version. 

The trial version will expire after 30 days. Attaching a dongle will not re-activate the trial version. The fully 
functional SpeechExec Pro Dictate and SpeechExec Pro Transcribe versions have to be installed from the 
original product CD. 

The trial version is an independent version of the SpeechExec product insofar as it installs and enables you to 
evaluate both the SpeechExec Pro Dictate and the SpeechExec Pro Transcribe solution. 

The trial version is available as a download only. 

The trial version does not allow recording into the DSS format. 

The recording and playback length is restricted to 30 seconds for a dictation. This means you have to restart 
recording and playback every 30 seconds. 
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Dongle 
The SpeechExec workstation licensing scheme operates with a dongle. A dongle is a security device connected 
to the USB port of your computer. It enables you to use the SpeechExec software package on your computer but 
also prevents its unlicensed use on any other computer. The different SpeechExec components listed above 
require individual dongles. Your dongle looks similar to this: 

 
The SpeechExec dongle has been designed as a USB HID class device (USB 2.0) with a unique ID. Additionally 
it works as a USB hub to support other Philips dictation devices. 

Important 

Do not remove the dongle while SpeechExec is running. You will not be able to create or open dictations any 
longer. The built-in security mechanism however guarantees that you will be able to finish work on the 
currently open dictation. 

• 

• 

• 

• 

• 

• 

When the dongle is removed, recording into the DSS format is not possible any longer. This also applies to the 
currently open dictation. 

If no dongle is present when starting the program, you will receive an error message. Re-attach the dongle. 

The dongle has been designed especially for and tested only with Philips USB dictation devices. Other USB 
devices may not function correctly when connected to the PC via the SpeechExec dongle. 

Troubleshooting 
If you receive a message that no valid license can be found or if you encounter dongle-related problems, try the 
following: 

Disconnect your SpeechExec dongle from the USB port and reconnect it. 

Verify that your dongle works correctly via the Device Manager tool in your Control Panel. 

You find the Device Manager on the Hardware tab of System in Control Panel. The Device Manager is an 
administrative tool for viewing and changing device properties, updating device drivers, configuring device 
settings and uninstalling devices. 
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When you open the Device Manager, verify that a device of the type 'USB Human Interface Device' is listed. 
To make sure that the listed 'USB Human Interface Device' is your SpeechExec dongle, disconnect any other 
USB devices (USB SpeechMike, USB mouse, etc.). 
A yellow exclamation mark next to the device indicates a problem. Right-click the device and select 
Properties. Here you find the device status. For troubleshooting information, click the Troubleshoot button of 
the Properties dialog box. 

Some PC providers limit the output power of USB ports to 100mA (milliamps). These USB ports are called 
bus-powered USB ports. Such ports may not provide enough power for some USB devices to function 
properly. In this case, connect a self-powered USB hub to the USB port of your PC, then connect the USB 
device via the self-powered hub. 

• 

• 

• 

If you are using a site license, make sure that you are connected to your license server. 

In case of site licenses, also make sure that your network connection works properly. 

You can verify your connection settings by opening the corresponding entry in your Control Panel. 

Phases and states 

In SpeechExec, dictations are classified by phases and states.  

A phase is a distinct stage in the life-cycle of a dictation where the dictation is processed in a specific way. For 
example, recording and transcription are phases. 

• 

• A state is a particular condition of a dictation within a phase. SpeechExec dictations can have the following 
states: pending, in progress, suspended and finished. 

Phase and state definitions 
Recording 

An author records a dictation and a sound file is created. 

Transcription 
The transcriptionist plays back the dictation, types it out and thus creates a text document. 

Pending 
The dictation has not been worked upon in this phase. 

In progress 
The dictation is being worked upon at the moment. 

Suspended 
The dictation has been opened for work, but closed again before it has been finished. 

Finished 
Work on the dictation has been finished in this phase. 

Note: When the state of a dictation is 'in progress' or 'suspended', the dictation is locked  for any users 
other than the author or transcriptionist who is currently working on the file. The author or transcriptionist has 
exclusive access to the file. 

Transitions 
The life-cycle of a dictation involves the following transitions: 

Recording in progress: The author is working on the dictation and has exclusive access to the dictation. • 

• 

• 

• 

• 

• 

Recording suspended: Recording can only be continued by the same author. 

Transcription pending: The author has finished recording; the dictation has not yet been opened by a 
transcriptionist. 

Transcription in progress: The transcriptionist is working on the dictation and has exclusive access to the 
dictation. 

Transcription suspended: Transcription can only be continued by the same transcriptionist. 

Transcription finished: The transcriptionist has finished typing out the dictation. 
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Folder types 

When working with SpeechExec folders, you may have noticed that not all folders behave the same way. The 
most noticeable difference is between the Intray folder and any other default SpeechExec folders, e.g. the 
Suspended or Finished folders. If you are looking for enlightenment, maybe this is the topic for you. This topic 
tries to explain how SpeechExec folders work and where the differences are. For those amongst you, who 
understand and are already enlightened and do not find the folder behavior unusual, please pardon the author's 
simplistic approach and simply ignore this topic.  

Physical and virtual folders 
This is the first trap. SpeechExec uses are two different folder concepts: physical folders and virtual folders. The 
explanations below are general in nature and do not apply to SpeechExec folders exclusively. 

A physical folder is a folder which you can actually see and find on your file system. This means that physical 
folders are directly tied or mapped to a folder on your computer; they are physically present (hence their name). 

A virtual folder functions as a repository for files that have no logical relationship to each other on a disk drive. 
You can think of a virtual folder as a container into which you can place whatever files you want. Virtual folders 
are a useful way to organize files that can be distributed across your file system. The most common use case for 
this type of folder is when you want to organize files from several different locations into one location. 

Note: SpeechExec uses the virtual folder concept for the transcripionist's Intray folder only. 

Intray folder 
The transcriptionist's Intray folder organizes all input folders for the transcriptionist into one simulated 'overview' 
folder. The input for the Intray comes by default from the Pending folders (which are mapped to the authors' 
Finished folders) from the Suspended folders and the Inbox folder. For more information about the SpeechExec 
folder structure, refer to the Tree view topics in the SpeechExec Pro Dictate and SpeechExec Pro Transcribe 
Online Helps respectively. 

 
You can see the Intray folder in the transcriptionist's tree view where it appears like any other folder. However, 
were you to go and search for this folder in your Windows Explorer, you would not be able to find it. Additionally, 
the following restrictions apply: 

You can rename and hide the Intray folder but you cannot delete it. • 

• 

• 

You cannot create subfolders for the Intray. 

When you copy or move dictations to the Intray, a dialog box is displayed where you have to select the 
physical folder you want to copy/move the dictations to. 

Note: You cannot create any other virtual folders in SpeechExec. 
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Physical folders 
Physical folders, as mentioned above, really exist in your file system. Examples of physical folders in SpeechExec 
are the Pending, Suspended and Finished folders. By default they are located in <My 
Documents>\SpeechExec. They are mapped to the following folders respectively: _pending, _supended and 
_finished. You will notice that the folders can be preceded by either an 'a' or a 't'. This indicates whether it is an 
author or a transcriptionist folder: 

 
Here you can already see a crucial SpeechExec concept in practice: the name of a folder in your SpeechExec 
tree view does not necessarily have to be same as the name of the mapped folder in the file system. SpeechExec 
has taken the folder concept to a new dimension. And this is where things are starting to get complex. 

Folders and the workflow 
Some physical folders have special functions for the SpeechExec workflow. These are folders which are used to 
define, and are dedicated to, specific steps in the workflow. Examples are the Finished, Archive and Local 
Work folders. Other folders, these will be mostly user-defined, are used for organizing, grouping and moving 
dictations. An example could be a user-defined Personal folder which an author creates and uses for storing 
personal correspondence. 

The default Finished folder, on the other hand, is used by the SpeechExec workflow for storing dictations which 
the author has finished recording. In the SpeechExec folder view, these dictations can be found in the author's 
Finished folder; they have the state <Transcription pending>. The Finished folder is usually mapped to a 
transcriptionist's Pending folder. The transcriptionists will probably not see any individual pending folders in their 
folder views, the dictations will simply appear in their virtual Intray folders. 

Note: Authors can create standard (physical) folders in SpeechExec. Transcriptionists can create standard 
folders and new Pending folders. Any new Pending folder will be automatically linked to the transcriptionist's 
Intray and its contents will appear in the Intray folder. 
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Mapping a new folder 
This section describes how to create a new folder in the SpeechExec tree view pane and map it to an already 
existing folder in the file system. Beware: this does not create a new folder in the file system. 

1. Right-click inside the tree view pane and select New Folder. The corresponding dialog box is displayed. 

2. Type in the name for the folder, modify the visibility properties, if required, and browse for the path: 

 
Let's assume you want to use the default SpeechExec folder location and point the path to <My 
Documents>\SpeechExec. 

3. Click OK. 

The result may probably not be what you expected. Let me repeat what happened: you created a new folder in 
the SpeechExec tree view pane only and mapped it to an already existing folder in the file system, in our 
example, the SpeechExec folder on the C drive. The contents and any underlying folder structure is inherited 
from the SpeechExec folder. In your tree view, you now see the following: 

 
When you expand the folder, you see: 

 
So what has happened is that you have only mapped your new SpeechExec folder to an existing folder structure. 
You will not be able to find an All folder anywhere in your file system. The contents of the a_finish folder will be 
identical to the contents of the Finished folder, the contents of the a_suspended folder identical to the ones in the 
Suspended folder. 

Creating new folders in the SpeechExec tree view and mapping them to folders in the file system is useful for 
transcriptionists for organizing their input. This way they can, for example, create individual folders for the authors 
they work for and map them to the required author folders. 

Now, when, on the other hand, you really want to create an authentic new folder, see below. 
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Creating a new folder 
This section describes how to create not only a new folder in the SpeechExec tree view pane but at the same 
time also a new folder in the file system. 

1. Right-click inside the tree view pane and select New Folder. The corresponding dialog box is displayed. 

2. Type in the name for the folder, modify the visibility properties, if required, and browse for the path. 

 
3. In the Browse For Folder dialog box, define the location for the new folder, for example: My Computer\Local 

Disk (C:). 

4. Next, and this is the really important part, click Make New Folder:  

Congratulations! You have just created a new folder in the file system, on your C drive. If you want to use the 
same folder name which you have defined in the New Folder dialog box, type in the name (right-click and 
select Rename): 

>>  
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5. Click OK. When you now go looking for your new folder, you can see it not only in your SpeechExec tree view 
but also on your C drive. 

SpeechExec:  C drive:  

Local Work folder 

If your SpeechExec system has been set up in such a way that it operates within a network, certain important 
workflow folders will be located on the network. When you work with such a configuration, SpeechExec will verify 
the availability of network folders for certain file operations. If network folders are unavailable, SpeechExec will 
use the Local Work folder concept:  

You copy/move dictations manually to the Local Work folder because you know you will not have a network 
connection, for example, you want to work at home. 

• 

• 

• 

• 

• 

• 

SpeechExec encounters an unavailable network connection and uses the Local Work folder for certain file 
operations. For more information, see below. 

Note: When you lose your network connection while working on a dictation, you will not be able to continue with 
this dictation as long as the network is unavailable. You will be notified by SpeechExec when the network is 
available again. SpeechExec will also prompt you to synchronize any dictations you may have created in the 
Temp folder in the meantime. 

Network unavailability 
When SpeechExec tries to perform a file operation, which requires an active network connection, but finds out 
that the network is unavailable, the dictations will be transferred to the Local Work folder. The reasons may be 
one of the following: 

The dictation was created in the Temp folder and the dictation state changes to either <Transcription pending> 
or <Recording suspended>. The corresponding Finished and Suspended folders are located on the network 
but are currently not available; the dictations cannot be moved to these folders. The dictations are transferred 
to the Local Work folder. 

The download folder for DPM files, the Finished or Suspended folders on the network are not available. The 
dictations are transferred to the Local Work folder. 

The option for using a temporary copy when working with dictations is not activated and the Suspended folder 
on the network is not available. The dictations are created directly in the Local Work folder. 

You actively move the dictations to the Local Work folder because you know there will be no network 
connection. This may be the case, for example, when you plan to do some work at home or because you 
know that the network will be shut down for maintenance. 

Note: Dictations with the <Transcription pending> state are dictations which you, as the author, consider as 
finished. Such dictations are moved to the Finished folder. Author and transcriptionists usually share the 
Finished folder. When an author finishes a dictation, it is moved to this folder and becomes <Transcription 
pending>. The transcriptionist accesses this folder and types out the dictation in it. 
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If you, the author, have configured workflow settings for dictations with the <Transcription pending> state, 
some actions may be delayed until the Finished folder is available again on the network. The following 
workflow actions will be performed regardless of network availability: 

Displaying the Dictation Properties dialog box. • 

• 

• 

• 

• 

Renaming of files based on the configured dictation properties. 

Conversion. 

Encryption. 

Sending dictations via email. 

This would, for example, enable the following use case: You are away from the office on a business trip and 
have recorded dictations on your DPM. You download the dictations to SpeechExec on your laptop but you do 
not have an email or network connection. You have configured settings for the renaming of dictations and 
encryption; these actions are performed. You have also configured settings for emailing dictations; this action 
cannot be performed. The downloaded dictations are stored in your Outbox and the Local Work folder. 
Back in your hotel or in your client's office you can make an email connection. When you now click Send and 
Receive  in your SpeechExec program, the dictations stored in your Outbox are transferred. 
When you return to your office and have the network connection again, synchronization is performed. For 
more information, see below. 

For more troubleshooting information, refer to the corresponding section in this Online Help. See: Lost network 
connection. 

Synchronization 
When you start SpeechExec or when you select Synchronize from the File menu, the program verifies whether 
there are any dictations in the Local Work folder. This folder is usually empty. 

When SpeechExec finds dictations, the program verifies the availability of the required network folders to start 
synchronization. A message is displayed which informs you about the dictations which are going to be moved 
from the Local Work folder to the respective network folders. 

Note: If dictations with the state <Transcription pending> are located in the transcriptionist's Local Work folder, 
the target folder on the network is defined by the author profile. If no author profile has been defined, the author's 
Inbox folder will be used for synchronization. 

Instructions 

SpeechExec supports the recording and playback of instructions. Instructions can be compared to notes or 
comments which an author may want to pass on to the transcriptionist. They usually contain information which is 
relevant to the dictation but does not have to be typed out.  

SpeechExec supports these types of instructions: 

Spoken instruction - Comments recorded by the author during dictation which are stored within the dictation 
sound file at the position in the sound file where the instruction was actually recorded. Examples for spoken 
instructions are 'insert a paragraph here' or 'correct spelling is Z E L A Z O W S K I'. 

• 

• Special instruction - Remarks recorded by the author usually at the start of a dictation with special 
information relating to the dictation. Special instructions are stored in a separate file from the dictation sound 
file. Every dictation sound file can have one special instruction sound file. Examples for special instructions 
are 'use the memo template for this dictation' or 'make a printout of the finished document and bring it to me 
for signing'. 

Note: The SpeechExec Player does not support recording of instructions. 

Note: You can also add a written comment to a dictation as part of the dictation properties. 
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Archive, backup and purge 

The default SpeechExec configuration comes with default folders for archiving and making backups of dictations. 
The Archive and Backup folders are located by default in <My Documents>\SpeechExec; they are hidden by 
default. Additionally, SpeechExec provides a function for purging dictations.  

Archive folder - This stores all dictations with the state <Transcription finished>. Authors map the path of their 
Archive folder to the transcriptionist's Finished folder. Alternatively, authors can also configure that any 
dictations for which they receive a 'transcription finished' notification are moved automatically from the Sent 
Items folder to the Archive folder. See: General Settings, Transcription finished page. 

• 

• Backup folder - This stores backup copies of dictations for use in the event of failure or loss of the original. 
Authors can configure at what stage in the workflow backup copies should be made. The options are to create 
backup copies when a dictation is finished or when dictations are downloaded from the DPM. See: General 
Settings, Dictation finished/automatic download (DPM) page. 

To make either folder visible, do the following: 

1. Open the General Settings dialog box from the Settings menu or click this toolbar button:  

2. Expand the Worklist entry in the left pane and select Folders. 

3. Select the Archive or Backup folder from the list; the folder properties are displayed. 

4. Change the Visible property to Yes. 

 
>> 

 
5. Click OK to confirm the changes and close the dialog box. The Archive or Backup folder will now appear in 

your SpeechExec tree view. 

 

Making backups of dictations 
The Backup folder stores copies of dictations for safeguarding them from loss. Backups can be compared to 
'insurance' copies. It is recommended that you make backup copies for the following use cases: 

Use case 1 - The author has worked on and finished a dictation locally (e.g. using the Temp folder), the 
dictation is now moved to the Finished folder which is located on the network; the Finished folder is shared 
by several users. If another user accidentally deletes the dictation, a backup copy is avaible. 

• 

• 

• 

Use case 2 - Dictations are being downloaded from the DPM to a folder on the network. SpeechExec has 
been configured in such a way that the downloaded files are converted to a different audio format; the original 
files on the DPM are deleted when download is finished. If backup is enabled, SpeechExec will make safety 
copies of the original files before conversion and deleting are performed. 

Use case 3 - You copy dictations manually to the Backup folder. The dictations remain in the Backup folder 
until they are deleted manually. The dictation state remains unchanged. 
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Archiving dictations 
The Archive folder is the target location for dictations which have completed the SpeechExec workflow; their 
dictation state is <Transcription finished>. A dictation is in the <Transcription finished> state when the 
transcriptionist has finished typing out the dictation and clicked Finish in the Player module. 

The following use cases are supported: 

• 

• 
• 

• 

• 

• 

• 

• 

• 

• 

Use case 1 - Author and transcriptionist work within a LAN (Local Area Network). Author and transcriptionist 
folders, which are important for the SpeechExec workflow, are mapped (see: Folders and the workflow). 
Finished dictations are moved to the Archive folder automatically. For this use case to work properly, the 
following configurations have to be made: 

The Archive folders of both author and transcriptionist have to point to the same location. 
The transcriptionist has to activate the setting for moving finished dictations to the Archive folder. See: 
General Settings, Transcription finished page (SpeechExec Pro Transcribe Online Help). 

Use case 2 - Author and transcriptionist do not work within a LAN. The transcriptionist receives the dictation 
via email or FTP. The author receives an email notification when transcription is finished. The finished 
dictation is moved to the Archive folder automatically. For this use case to work properly, the following 
configurations have to be made: 

Author and transcriptionist need to have their email/FTP profiles set up correctly. See: Delivery profiles - 
email, Delivery profiles - FTP and Delivery profiles - dial-up. 
The author needs to have notification enabled. See: General Settings, Notification page (SpeechExec Pro 
Dictate Online Help). 
The author has to define at what stage in the workflow the notification is to be sent. For this use case, 
select Finish. You can make a default setting for all dictations, see: General Settings, User preferences 
page (SpeechExec Pro Dictate Online Help). 
The author has to activate the setting for moving finished dictations from the Sent Items folder to the 
Archive folder. See: General Settings, Transcription finished page (SpeechExec Pro Dictate Online 
Help). 

Important: When you archive dictations, SpeechExec automatically creates subfolders below the Archive folder. 
A subfolder is created and named for the day when archiving is done; the naming convention for subfolders is 
YYYYMMDD (year-month-day). Additionally, the subfolders have the default prefix ARCH_. Example: Any 
dictations which were archived on May 5, 2005 can be found in the subfolder ARCH_20050505. These subfolders 
are used for purging dictations. For details, see below. 

Purging 
Purging permanently deletes dictations from the Archive folder. SpeechExec supports the following purge 
options: 

Automatic purge - When you start SpeechExec, the program will verify whether the automatic purge option is 
activated. If it is, SpeechExec will permanently delete any dications which have been archived for longer than 
the specified number of days, including the respective subfolders. 

Manual purge - When you click the Purge Now button, SpeechExec will permanently delete any dications 
which have been archived for longer than the specified number of days, including the respective subfolders. 

For information about the available purge settings, see: General Settings, Purge page. 
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Basics 

Starting the program 

To start the program, go to the Start menu of your Windows operating system and select Programs, 
SpeechExec. The program main window is opened.  

Starting the program in hidden mode 
If the program has been started in hidden mode the main window is not opened, the program is active in the 
background. When the program is active in the background it is available via the program icon in the notification 
area of the Windows task bar:  

Note: The program can be started in hidden mode using the /h command line parameter . Alternatively, if the 
appropriate setting is made during the installation process, the program is automatically started in hidden mode, 
and active in the background, when the PC is started. 

Right-click the icon to display the program menu with the following menu commands: 
Show Worklist 
Hide Worklist 
Exit Worklist 
Compact Mode (Recorder) - only available if the Recorder is in expanded mode 
Expanded Mode (Recorder)  - only available if the Recorder is in compact mode 

Closing the program 
To completely shut down the program, go to the File menu and select Exit. 

To close the program but still have it active in the background, click the x in the top right corner of the main 
window. The program icon is displayed in the notification area of the Windows task bar. 

Main window 

In SpeechExec, transcriptionists work with the SpeechExec Pro Transcribe module. This module enables you to 
manage your dictation list, define dictation properties and make various settings. You can also open the Player 
module, from the Worklist module, to perform transcription tasks. This is the SpeechExec Pro Transcribe window:  

 

Menu bar 
The menu bar provides menu commands for performing the various tasks, for managing dictations, making 
settings and configuring the SpeechExec Pro Transcribe window. For a full list of menu commands and a short 
description of their functions, see: Menus. 

Toolbar 
You can control many functions available in the SpeechExec Pro Transcribe window via the toolbar buttons. For a 
full list of the available buttons and a short description of their functions, see: Toolbar. 
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Tree view 
The tree view displays your folder structure. The structure depends on your personal settings or preconfigured 
settings. A plus sign ( ) to the left of a folder means that a folder contains subfolders; click the plus sign to 
expand the tree. For a description of the default folder structure, see: Tree view. For information on working with 
folders, see: Folder operations. 

Dictation list 
The dictation list displays information on the dictations stored in the selected folder. The columns display the 
properties of the dictations. For information on your dictation list see: Dictation list. For a full list of dictation 
properties, see: Dictation properties. 

You can change the focus between the tree view and the dictation list by clicking inside each pane. 

Status bar 
The status bar at the bottom of the window displays information on dictation management, such as your user 
name and role, the number of dictations in the selected folder and the number of dictations with priority assigned. 

Menus 

SpeechExec provides the following menus:  

File 
Edit 
Folder 
DPM 
Settings 
View 
Help 

File 
Start Transcription 

Opens the selected dictation. If more than one file in your Worklist is selected, the first selected file is opened. 
Depending on your personal settings or preconfigured settings, a word processor is also opened. 

Playback 
Starts playback of the selected dictation. If more than one file in your dictation list is selected, the first selected 
file is played back. Select the menu command again to stop playback. 

Play Special Instruction 
Starts playback of the special instruction associated with the dictation. If more than one file in your dictation list 
is selected, the first selected file is played back. Special instructions are saved in a separate file from the 
dictation file; playing back a special instruction does not open the dictation file. 

Submit for Speech Recognition 
Submits the selected dictation for speech recognition. 

Send and Receive 
Connects to the email system and checks for incoming and outgoing emails. Any outgoing emails are sent. 

Import 
Displays the dialog box for importing files created outside SpeechExec. 

Convert 
Converts the selected dictation file to the configured audio format. If more than one file in your dictation list is 
selected,all files are converted. 

Encrypt 
Encrypts the selected dictation. You must enter and confirm an encryption password. You can select more 
than one dictation (CTRL and SHIFT keys). 

Note: The encryption setting in the General Settings dialog box does not have to be activated to use this 
menu command.  

Decrypt 
Decrypts the selected dictation. You must enter the password used to encrypt the dictation. 

Synchronize 
Synchronizes your network folders with the contents of your Local Work folder. Dictation files which you have 
been working on locally are moved to folders on the network. For example, if you change a dictation file in the 
<Suspended> state to <Finished> it will be moved from your Suspended folder to your Finished folder. 
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Minimize 
Minimizes the Worklist to a button on the Windows taskbar.  

Exit 
Shuts down SpeechExec. 

Note: SpeechExec can now only be reopened from the Start menu. 

Edit 
Delete 

Deletes the selected dictation; you must confirm your action. Whether this file is permanently deleted or 
moved to the Recycle Bin depends on your personal or preconfigured settings. 

Rename 
Enables you to change the file name of the selected dictation. 

Copy to Folder 
Enables you to copy the selected dictation to another folder. Select a folder in the displayed dialog box and 
click OK; the dictation is now stored in both locations. 

Move to Folder 
Enables you to move the selected dictation to another folder. Select a folder in the displayed dialog box and 
click OK; the dictation is now stored in the new location. 

Change Dictation State 
Displays the Change Dictation State dialog box. Here you can change the state of the selected dictation. 
Select a state in the displayed dialog box and click OK.  

The dictation is moved to the designated folder, for example if you change the state from <Dictation 
suspended> to <Transcription pending>, the dictation is moved from your Suspended folder to your Finished 
folder. 

Note: You should be aware that changing the dictation state does not initiate follow-up tasks like automatic 
emailing or conversion. 

Note: You can select more than one dictation (CTRL and SHIFT keys) and change the dictation state of all. For 
example, if DPM files, which were not finished with the EOL button but are ready for transcription, are 
downloaded, they have the dictation state <Recording suspended>. This means that you cannot open them. 
You must change the dictation state to <Transcription pending>. 

Dictation Properties 
Displays the Dictation Properties dialog box. Here you can view and edit the properties. 

Folder 
Hide 

Hides the selected folder. The folder is not visible in the tree and is no longer available. 

Note: To make a hidden folder visible can only be done from the Folders page. of the General Settings dialog 
box.  

Delete 
Deletes the selected folder; you must confirm your action. 

Note: You can delete any folder that you have created yourself. If this option is not available the selected 
folder cannot be deleted. 

Rename 
Enables you to change the name of the selected folder. 

Folder Properties 
Displays the Folder Properties dialog box. Here you can view and edit the properties. 

For information on working with folders, see: 
Tree view 
Folder operations 
Worklist settings - folders 

DPM 
DPM Configuration 

Displays the DPM Configuration dialog box. This dialog box enables you to configure the DPM according to 
your individual preferences. 
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DPM Wizard 
Displays the DPM Configuration Wizard. This wizard assists novice users with configuring important DPM 
settings. 

Transfer Settings to DPM 
Sends the DPM configuration settings made in SpeechExec to the device when the DPM is connected to the 
PC. The device-specific settings in SpeechExec overrule settings on the device. 

Transfer Settings from DPM 
Retrieves the DPM configuration which is stored on the device when the DPM is connected to the PC. The 
settings from the device overrule the device-specific settings in SpeechExec. 

Import DPM Settings 
Enables you to browse for the location where configuration files are stored. The selected file is imported. The 
device-specific and program-specific settings stored in that file overrule the current settings in SpeechExec. 

Note: When you import a configuration file, a confirmation dialog box is displayed. You must confirm the 
import action in order for the settings in the configuration file to be applied to both SpeechExec and your 
device. 

Export DPM Settings 
Enables you to browse for the location where configuration files are stored. The current device-specific and 
program-specific settings are stored in that file. If required, the file can be exported and the configuration 
settings can be applied to other DPM devices. 

Settings 
General Settings 

Displays the General Settings dialog box. Here you can make settings for your Worklist module, dictations, 
DPM and Recorder module. 

Sounds and Audio Devices Properties 
Displays the corresponding Microsoft Windows dialog box. Here you can make sounds, audio and hardware 
settings. 

View 
Toolbar 

Shows or hides the toolbar. 

Status Bar 
Shows or hides the status bar. 

Folder Tree 
Shows or hides the dictation folders tree pane. 

Show Gridlines 
Shows or hides the gridlines between columns and rows in the dictation list. 

Filter On/Off 
Applies the configured filter to the dictation list. Select the menu command again to return to the unfiltered 
dictation list. 

Filters 
Displays the Filters dialog box. Here you can define filter conditions to display only items with specific 
properties. 

Columns 
Opens a menu with all available column headings in your dictation list. Activate the corresponding check box 
to display a column, clear the check box to hide a column. 

Sort 
Opens a menu with all available column headings in your dictation list. Select a column to sort your dictation 
list by the column. 

Refresh 
Updates the information displayed in the dictation list for the currently open folder. 

Help 
Contents and Index 

Opens the Online Help system. 

About 
Displays the About dialog box with general version and copyright information. 
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Toolbar 

These are the SpeechExec toolbar buttons:  

 Start Transcription 
Opens the selected dictation. If more than one file in your dictation list is selected, the first selected file is 
opened. Depending on your personal or preconfigured settings, a word processor is also opened. 

 Playback 
Starts playback of the selected dictation. Select the menu command again to stop playback. If more than one 
file in your dictation list is selected, the first selected file is played back. 

 Play Special Instruction  
Starts playback of the special instruction associated with the dictation. If more than one file in your dictation list 
is selected, the first selected file is played back. Special instructions are saved in a separate file from the 
dictation file; playing back a special instruction does not open the dictation file.  

Note: This button is available if the selected dictation has a special instruction. 

 Dictation Properties 
Displays the Dictation Properties dialog box. Here you can view and edit them. 

 Send and Receive 
Connects to the email system and checks for incoming and outgoing emails. Any outgoing emails are sent. 

 DPM Configuration 
Displays the DPM Configuration dialog box. 

 DPM Wizard 
Displays the DPM Wizard. 

 General Settings 
Displays the General Settings dialog box. Here you can make settings for your Worklist, dictations, DPM and 
the Recorder module 

 Filters 
Displays the Filters dialog box. Here you can define filter conditions to display only items with specific 
properties. 

 Filter On/Off 
Applies the defined filter to the dictation list. Click the button again to return to the unfiltered dictation list. 

 Refresh 
Updates the information displayed in the dictation list for the currently open folder. 

 Submit for Speech Recognition 
Submits the selected dictation for speech recognition. 

 Help 
Opens the Online Help system. 
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Tree view 

SpeechExec is delivered with the following default folders in your tree:  

 Local Work: Dictations that are worked on when the PC is not connected to the network. When the 
network is available the contents of this folder are synchronized with the system; synchronization of data takes 
place when the program is started or to accomplish this manually, go to the File menu and select 
Synchronize. If you know that the network will not be available, you can copy files, that you want to work on, 
here. 

• 

 temp: Dictations in the <In progress> state, if the equivalent setting has been made in Recorder/Player 
options. This folder is hidden by default but can be made visible. The path is a local path on your PC and 
cannot be changed. Subfolders can be created manually.  

• 

 Suspended: Dictations in the <Suspended> state. Dictations are moved from the Temp folder to the 
Suspended folder when you click Suspend in the Recorder window. Subfolders can be created manually. 

• 

You can also see these icons in your tree: 
 Suspended (no access to the network) 
 Suspended (network access is available) 

 Archive: Dictations in the <Transcription finished> state. This folder is hidden by default but can be made 
visible. A subfolder is created each day with the following naming convention: YYMMDD. The dictations that 
are archived on that date are stored in the subfolder. 

• 

Depending on the setting made, when transcription is finished, dictations which were sent by email are moved 
from the Sent Items folder to the Archive folder or deleted. 

 Intray: This is a virtual folder that gathers together all dictations that are available for you to work on. This 
includes dictations stored in other folders. 

• 

 Outbox: Dictations waiting to be sent by email or FTP. • 

 Sent Items: Dictations which have been successfully sent, by email or FTP, are moved here from the 
Outbox folder. 

• 

 DPM: Dictations that are currently located on the DPM. If a DPM is connected to the PC the folder name 
also indicates the version of the DPM, for example, DPM9450. 

• 

Dictation list 

Click a folder in the tree view to view the dictations stored in that folder in your dictation list.  

Click anywhere in a row of the list to select a dictation. Double-click a dictation to open it for editing. 

For information on navigating the dictation list with shortcuts, see: Keyboard shortcuts. 

Right-click a dictation to open a menu with the following commands: 

Delete 
Rename 
Copy to Folder 
Move to Folder 
Change Dictation State 
Dictation Properties 

For an explanation of these functions see: Edit menu. 

Columns 
Dictation properties are displayed in columns in your dictation list. The column heading describes the property. 
You can decide which columns you want displayed. Go to the View menu and select Columns. A menu with all 
available column headings in your dictation list is displayed. Activate the corresponding check box to display a 
column, clear the check box to hide a column. 

You can rearrange the order of the columns. Click a column heading and, using drag-and-drop, place it in the 
position you want. The new position is indicated by red arrows:  
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Sorting your dictation list 
You can sort your dictation list (ascending and descending) by any column. To sort your dictation list go to the 
View menu and select Sort. A menu is displayed (the column heading at the top of this menu is used as the sort 
criterion). Select a column heading, the dictation list is sorted in ascending order by this column. To sort in 
descending order, select the same column heading from the View menu again. 

You can create a hierarchy of sort criteria. In the order you want to sort for, select the column headings from the 
View menu. Each heading with this icon  (ascending) or  (descending) is included. 

You can also sort your dictation list by clicking the column heading. An arrow indicates if the column is sorted in 

ascending or descending order. This is an example of sorting in descending order:  

To apply multiple sort criteria, click the column headings and press and hold SHIFT:  

Color 
Some dictations are displayed with a different color: 

Locked: Dictations which are locked have a light gray background. Additionally, this symbol is displayed in the 
Locked column:  

• 

Priority: Dictations with a high priority have a specially configured color. The Priority you set determines which 
dictations have this color. 

• 

Filters 
You can filter your dictation list in order to display certain dictations only. 

Click the folder whose contents you want to filter. Click  on the toolbar to display the Filters dialog box where 
you define a filter. Once you have defined your filter click to apply the filter. Click again to return to the 
unfiltered dictation list. 

Editing properties 
To edit dictation properties directly in the dictation list, click a property and manually change the information. 
Properties which are dates can be changed via the displayed calendar.  

For more information on editing dictation properties, see: Editing dictation properties. 

For a description of all dictation properties, see: Dictation properties - overview. 

Keyboard shortcuts 

The following default keystroke combinations are available:  

F1 - Opens the Online Help. • 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

CTRL+C - Copies the selected dictation or the selected section of text. 

CTRL+X - Cuts the selected dictation or the selected section of text from the original location. 

CTRL+V - Pastes the dictation or the section of text to the new location. 

DEL - Deletes the selected dictation or the selected section of text. 

ESC - Undoes the selection of a section of the dictation marked for deletion. It removes the red frame from the 
section that indicates it is to be deleted. For more information, refer to the "Deleting" topic in the SpeechExec 
Recorder & Player Online Help. 

CTRL+N - Creates a new dictation. 

CTRL+O - Opens the selected dictation for editing. 

CTRL+O - Opens the selected dictation for transcription. 

CTRL+1 - Starts and stops playback. 

CTRL+2 - Starts and stops playback of a special instruction. 

CTRL+3 - Emails the selected dictation, the Send Email dialog box is displayed. 

CTRL+4 - Uploads the selected dictation to the FTP server. 
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CTRL+5 - Send and receive now: connects to the email system and checks for incoming and outgoing emails. 
Any outgoing emails are sent. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

CTRL+6 - Display the General Settings dialog box. 

Ctrl+7 - Displays the Dictation Properties dialog box. 

CTRL+8 - Display the DPM Configuration dialog box. 

CTRL+9 - Display the DPM Wizard. 

For a list of actions that can be assigned keyboard shortcuts, see: Keyboard settings. 

Navigating the main window 
Press the TAB key to move around the main window until the focus is on the area you want. Click the left mouse 
button in the tree view or the dictation list to give that area the focus. Click the right mouse button in the tree view 
or the dictation list to open a menu with commands relevant to that area. 

Menus on the menu bar can be opened by pressing ALT plus the underlined letter in the menu name. You can 
then press the menu command's underlined letter to select that command. 

Navigating the dictation list 
You can use the following mouse and keyboard keys to select dictations in the dictation list: 

To select a single dictation, click the left mouse button. 

To move to a dictation and select it, press the up and down arrows. 

To select a range of dictations, click the left mouse button over the first dictation and press and hold SHIFT. 
Then click the left mouse button over the last dictation. 

To select a range of dictations using only the keyboard, press SHIFT plus the up and down arrows. 

To select more than one dictation, click the left mouse button over the first dictation and press and hold CTRL . 
Then click the left mouse button over each dictation. 
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Using the Help 

Using the Help window 

The SpeechExec Online Help window contains the following information:  

Toolbar 
Hide/Show 

Hides the navigation pane. To reopen the pane, click Show. 

Locate 
Highlights the topic you are currently viewing in the table of contents. This is particularly useful if you are 
navigating via links in the topics and want to find which book the topic belongs to for future reference. 

Back 
Displays the last topic you have viewed in the topic pane. Use this button to move backwards through all the 
topics you have viewed in this session. 

Forward 
Moves forward through the topics you have viewed in this session. This button is only functional if you have 
already clicked Back to view previous topics. 

Refresh 
Refreshes the displayed topic. 

Home 
Displays the Start Page, which is the topic you first see when you open this Help system. 

Print 
Enables you to print either just the selected topic or all the topics in the selected book. 

Options 
Displays the following options: 

Hide/show Tabs 
Hides the navigation pane. To reopen the pane, click Show Tabs. 

Locate 
The same as the Locate button. 

Back 
The same as the Back button. 

Forward 
The same as the Forward button. 

Home 
The same as the Home button. 

Stop 
Stops a topic or URL loading in the topic pane. 

Refresh 
The same as the Refresh button. 

Internet Options 
Opens a dialog box where you can configure Internet options for Internet Explorer. 

Print 
The same as the Print button. 

Search Highlight On/Off  
Turns highlighting on and off for searching. 

Navigation pane 
The navigation pane contains the following tabs to help you find the right topic in the Help system: 

Contents 
This tab contains a table for contents for the Help. 

Index 
This tab presents an alphabetical list of keywords and enables you to search for index entries. 

Search 
This tab enables you to search for keywords throughout the entire Help system. 
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Favorites 
Here you can list favorite topics that you want to refer back to repeatedly. 

Topic pane 
The topic pane displays the Help topics, which contain descriptions and instructions that explain how to perform 
tasks in SpeechExec. 

When you click a topic in the table of contents, a keyword in the index, or a topic retrieved from the search 
engine, the contents of the Help topic display in the topic pane. 

Help topics often contain links to other related topics. Click the link to go to that topic. To return to your original 
topic, click the Back button on the toolbar or right-click with your mouse inside the topic pane and select Back. 

Using the table of contents 

Click the Contents tab at the top of the navigation pane to display the table of contents for the Help. This consists 
of a set of books, which are similar to chapters in a printed document, and topics. Books are listed in the order 
that most users will need them when starting to work with SpeechExec.   

Books - Click the plus sign ( ) next to a book to reveal the topics it contains, or double-click the book title. 
Books may contain sub-books, which you can open to display further topics. 

• 

Topics - Click a topic title to display that topic in the topic pane. • 

Using the index 

Click the Index tab at the top of the navigation pane to display all index entries in the pane. The index is an 
alphabetical list of keywords. Select a keyword and click Display to display the related topic in the topic pane, or 
double-click the keyword.  

To search for a keyword: 

Scroll through the list using the scroll bar and arrows to the right of the navigation pane. • 

• Enter a word or phrase in Type in the keyword to find. If a keyword already exists that matches your entry, 
the list will automatically display that keyword. If no keyword exists, the list will display the word nearest to 
your entry at the top. 

Note: If the keyword you have selected occurs in more than one topic, a dialog box is displayed listing all topics 
relating to that keyword. Select the topic you want to see and click Display to open the topic in the topic pane. 
Alternatively, double-click the topic. 

Using search 

Click the Search tab at the top of the navigation pane to display the search engine options in the pane. The 
search engine enables you to search for specific words or phrases throughout the Help system.  

To locate topics with the search engine: 

1. Enter a word or phrase you want to search for in Type in the word(s) to search for. 

2. If you want to qualify your search, or use a combination of words, click the  icon to the right of the field, 
and select from the following options: AND, OR, NEAR, NOT. 

3. Click List Topics. 

All topics in the Help system that contain the word(s) you searched for are listed in Select Topic to display.  

4. Select a Help topic and click Display, or double-click it. The topic is displayed in the topic pane. All 
occurrences of the word(s) you entered are highlighted.  

Note: You can turn the search highlight on and off. Click Options on the toolbar and select Search Highlight 
Off. This will not refresh the topic; you must reload the topic by double-clicking it in Select Topic to display. 
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Using favorites 

If you find yourself looking for certain topics on a regular basis, you can add them to your list of favorites on this 
tab. This enables you to find them instantly, without using the search engine, table of contents or index.  

Adding topics to the favorites list 
When you come across a topic that you want to add to the list, do the following: 

1. Open the Favorites tab. The topic title is displayed in Current topic. 

2. Click Add to add the topic to the favorites list. 

Removing topics from the favorites list 
To remove a topic from the list, select the topic and click Remove. 

Using the favorites list to view topics 
To view topics, do the following: 

1. Open the Favorites tab. Your list of favorite topics is displayed. 

2. Select the topic you want to see and click Display, or double-click the topic. The selected topic is displayed in 
the topic pane. 
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Working with SpeechExec 

Working with SpeechExec - overview 

This section explains how to use SpeechExec Pro Transcribe for various transcription tasks. Use the following 
links to access the individual Help topics.  

Starting transcription • 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Finishing transcription 

Suspending transcription 

Closing transcription 

Notifications and reminders 

Email notifications 

Creating author profiles 

Setting up your email profile 

Setting up your FTP profile 

Editing dictation properties 

Folder operations 

Downloading DPM files 

Importing dictations 

Starting transcription 

You start transcription by selecting a dictation with the state <Transcription pending> or <Transcription 
suspended> in the dictation list.  

 

 

 
When you open the dictation, the state changes to <Transcription in progress>. 

How to: start transcription 

1. In your SpeechExec Pro Transcribe window, select a dictation from the list and click  on the toolbar or go to 
the File menu and select Start Transcription. You can also double-click the dictation directly in the list. 

2. Depending on your personal settings or preconfigured settings, the Dictation Properties dialog box may be 
displayed. Review and, if required, edit the properties. Click OK to save your changes and close the dialog 
box. 

3. The SpeechExec Player opens with the dictation. The file name is displayed in the title bar: 
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4. If you have defined a word processing program for transcription, e.g. Microsoft Word, it will also be opened. 

You can now start playback and transcription of the dictation. 

The Player window responds to the playback in the following way: 

The position slider moves to the right to indicate your current position in the dictation sound file. 
Additionally, the length of the sound file is displayed in HH:MM:SS (hours:minutes:seconds) above the 
slider: 

• 

 
The dictation activity and the number of spoken instructions (5) are displayed at the bottom of the Player 
window. The status area also indicates if a special instruction is available. 

• 

 
Note: During playback, the focus remains on the Player window. The SpeechExec Pro Transcribe window may 
be visible in the background. The information displayed in that window is updated in the background, for example, 
when new files are added to the dictation list. The SpeechExec Pro Transcribe window does not, however, accept 
user input until transcription is finished, canceled or suspended. 

Temporary copy 
The default setting for transcriptionists when working on dictations is to use a local copy, see: General Settings, 
Recorder/Player, Options. 

 
When you open a dictation for transcription, the dictation is copied to the transcriptionist's local Temp folder. Any 
file operations which take place are performed on the local copy of the dictation. When work on the dictation is 
finished, the contents of the Temp folder are copied back to the network folder. 

Finishing transcription 

When you finish transcription, the dictation is closed, marked as finished and moved to the Archive folder. This is 
the default setting, see: General Settings, Finish transcription.  

 

How to: finish transcription 
1. The dictation is open in the Player window. To finish it, you have the following options: 

Click the corresponding button in the Player window:  • 

Go to the File menu and select Finish. • 
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2. Depending on your personal settings or preconfigured settings, the Dictation Properties dialog box may be 
displayed. Fill in the required information and click OK. 

The dictation is saved, closed and moved to the Archive folder. The Player window is closed and the focus 
changes back to the SpeechExec Pro Transcribe window. 

You may now be asked if you want to transcribe the next dictation. This will be the dictation which comes first 
in the dictation list depending on your current sorting. For this confirmation dialog box to be displayed, the 
following setting has to be enabled (see: General Settings, Finish transcription): 

 

Suspending transcription 

When you suspend transcription, the dictation is closed and marked as suspended. The dictation will remain in its 
original location unless you activate the setting for using the Suspended folder (see: General Settings, 
Start/suspend transcription):  

 

How to: suspend transcription 
1. The dictation is open in the Player window. To suspend it, you have the following options: 

Click the corresponding button in the Player window:  • 

Go to the File menu and select Suspend. • 

2. Depending on your personal settings or preconfigured settings, the Dictation Properties dialog box may be 
displayed. Fill in the required information and click OK. 

The dictation is saved and closed. This means that work on the dictation is interrupted temporarily and will be 
continued at a later time. The Player window is closed and the focus changes back to the SpeechExec Pro 
Transcribe window. 

Closing transcription 

When you close transcription, the dictation is closed without saving the changes that have been made to it.  

How to: close transcription 
1. The dictation is open in the Player window. To close it, you have the following options: 

Click the corresponding button in the Player window:  • 

Click the Close button in the title bar of the Player window:  • 

Go to the File menu and select Close. • 

2. You must confirm the close operation. 

The dictation is closed without saving any changes. It remains at the location where it was stored prior to 
opening. The transcription state also remains unchanged. The Player window is closed and the focus changes 
back to the SpeechExec Pro Transcribe window. 

Notifications and reminders 

You can configure how you want to be notified about new dictations in your Intray folder. Your Intray folder 
organizes all your input folders into one simulated 'overview' folder. The input for the Intray comes by default from 
the Pending folders, which are mapped to your authors' Finished folders, from your Suspended folders and your 
Inbox folder. For more information, see: Folder types.  

How to: configure notification 
When you configure notification you will receive a visual or an acoustic signal when new dictations are available 
for transcription. Proceed as follows: 

1. On the General Settings, Notification page, activate the Notification on option. 
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2. Define what type of notification you want, for example, Visual notification. 

 
The available options are: 

Urgent dictations only - You will only receive notifications for dictations which have a priority value equal 
to or above the threshold defined on the General Settings, Dictation list page. 

• 

• 
• 

Visual notification - A dialog box will be displayed when a new dictation has arrived. 
Sound notification - An audio signal will be played when a new dictation has arrived. Click Browse to 
select your preferred sound. 

3. Click OK to close the General Settings dialog box and save your configuration. 

How to: configure reminders 
Reminders are messages which inform you about your current workload. Proceed as follows: 

1. On the General Settings, Notification page, activate the Reminders on option. 

2. Define the interval for repeatedly displaying the reminder message, for example 5 minutes. 

 
3. Click OK to close the General Settings dialog box and save your configuration. 

How to: configure automatic closing 
This setting will automatically close any SpeechExec notification and reminder messages. Proceed as follows: 

1. On the General Settings, Notification page, activate the corresponding option: 

 
2. Define for how long the message should be displayed before it is closed automatically. 

3. Click OK to close the General Settings dialog box and save your configuration. 

Result 

The result of the example configuration from above is: 

You will receive a visual notification when new dictations have arrived in your Intray folder. • 

 
A reminder message will be displayed every 5 minutes. • 

• The notification and reminder messages are displayed for 60 seconds and will then be automatically closed. 
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Email notifications 

Authors can configure that they are notified about the transcription progress of dictations. These notifications are 
delivered to the author via email and relate to a specific stage in the transcription workflow, for example when you 
open a dictation for transcription.  

Transcriptionists can view and edit the notification settings in the Dictation Properties dialog box of a dictation. To 
display the Dictation Properties dialog box, select the corresponding menu command from the Edit menu or 
click this toolbar button: . 

Notification stages 
If the author has made a notification setting, the stage will be displayed in the Notification field: 

 
This setting will send a notification to the author when you open a dictation for transcription. 

You could, for example, add another setting so that the author also receives a notification when transcription is 
finished: 

 

Notification attachments 
The author may request that you attach a file to the notification, for example, the typed out document. The 
attachment function is only available when sending a notification that transcription is finished. If no such setting 
has been made by the author but you want to attach a file to the notification, make the corresponding setting as 
shown below. 

 
You will now be prompted to create an attachment when you finish transcription. The author will be prompted to 
save the attachment. 

Notification address 
The address field lists the email addresses of where to send the notification to. You can enter more than one 
address in this field; addresses have to be separated by ';'. 
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Creating author profiles 

It is recommended for transcriptionists that they set up author profiles. Author profiles are used to identify 
dictations for individual authors. The following use cases are supported:  

Dictations reveived via email/FTP: When authors send their dictations via email or FTP, the author profiles are 
used to detach the dictations to the respective input folders on the transcriptionist's side. If no author profile is 
defined, the Inbox folder is used. 

• 

• 

• 

• 

• 

Dictations downloaded from DPM: If author profiles have been defined, the DPM dictations are downloaded to 
the specified destination folder. The author name in the .dss file is used to define the destination folder. If no 
author profile is defined, the dictations are downloaded to the Inbox folder. 

Synchronization: When the contents of the Local Work folder are synchronized with the network folders, the 
target network folders for dictations with the state <Transcription pending> are defined by the author profiles. If 
no author profile is defined, the Inbox folder is used for synchronization. 

For more information, see: Folder types, Local Work folder. 

Decryption 
When authors encrypt their dictations, you can store the decryption password as part of the author profile. This 
means that the dictations will be decrypted automatically without you having to enter the password every time an 
encrypted dictation arrives. 

If SpeechExec does not find an author profile for an encrypted dictation, the following use cases are supported: 

SpeechExec will try to decrypt the dictation with the substitute password. This is a universal password shared 
between authors and transcriptionists system-wide. 

If the substitute password does not work, you will be prompted to enter a password. 

Note: Transcriptionists can encrypt dictations based on the author profile. If no author profile is defined, the 
substitute password will be used for encrypting dictations. 

How to: create an author profile 
To set up an author profile, do the following: 

1. On the General Settings, Author profiles page click Add. 

The New Author Profile dialog box is displayed. 

 
2. Enter the required information and click OK. This saves your author profile and closes the dialog box. 

Setting up your email profile 

The email profile links SpeechExec to the email program you are using for sending and receiving email 
messages. You can also have different email profiles defined, for example when you use different email clients in 
the office and at home.  

To set up your email profile, do the following: 

1. Open the General Settings, Email profile page. 

2. Click Add. The New Email Profile dialog box is displayed. Select the profile you are using, e.g. Simple MAPI, 
and type in a profile name. The following profile options are available: 

Simple MAPI • 
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Extended MAPI • 

• 

• 
• 

MAPI (Messaging Application Programming Interface) is a Microsoft Windows programming interface that 
enables a client application to send to and receive mail from Exchange Server or a Microsoft Mail (MS 
Mail) messaging system. Microsoft applications such as Outlook, the Exchange client and Microsoft 
Schedule use MAPI. Simple MAPI provides standard email functions, while Extended MAPI adds full 
calendaring and workgroup capabilities. 

SMTP/POP3 

SMTP (Simple Mail Transfer Protocol) is the standard email protocol on the Internet used for sending 
email messages between servers. SMTP defines the message format and the message transfer agent 
(MTA) which stores and forwards the email. SMTP servers route SMTP messages throughout the Internet 
to a mail server that stores incoming mail messages. The messages can then be retrieved with an email 
client using POP3. The mail server uses POP3 to communicate with the user's email program. 
POP3 (Post Office Protocol 3) is a standard interface between an email client program and the mail server. 
POP3 is the most common access protocol used for Internet email. POP3 stores incoming email 
messages until users log on and download them. All pending messages and attachments are downloaded 
when users check their email. 

Note: When you use SMTP/POP 3, you do not need to have an email client running on your PC. 

Lotus Notes 
Novell GroupWise 

 
3. Click OK to save the new profile and close the dialog box. 
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4. Depending on your selection in step 2, either the MAPI Settings, the POP/SMTP Settings, the Lotus Notes 
Settings or the GroupWise Settings dialog box is displayed. 

  

5. Fill in the required information and click OK to save your changes and close the dialog box. The profile is now 
listed on the Email profile page. 

6. Select your preferred profile from the list and click Set As Default. 

 
Important: If you do not set a default profile, you will not be able to make email configurations for the delivery 
of emails. 
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Setting up your FTP profile 

FTP (File Transfer Protocol) is a standard Internet protocol and the simplest way to exchange files between 
computers on the Internet.  

The FTP profile links SpeechExec to the FTP location. You can also have different FTP profiles defined. 

To set up your FTP profile, do the following: 

1. Open the General Settings, FTP profile page. 

2. Click Add. The New FTP Profile dialog box is displayed. 

 
3. Type in the name for the new profile and click OK. The name is saved, the dialog box is closed and the FTP 

Settings dialog box is displayed. 

 
4. Fill in the required information (see: FTP Settings dialog box) and click OK. This saves your settings and 

closes the dialog box. The profile is now listed on the FTP profile page. 
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5. Select your preferred profile from the list and click Set As Default. 

 

Editing dictation properties 

Dictation properties are characteristics of a dictation file used to define its state, appearance, or value. These 
properties include, for example, the file type, file size and creation date. To access the dictation properties, you 
have the following options:  

You can configure which stage of the workflow to have the dictation properties displayed, see: Dictation 
properties. 

• 

• Select a dictation in the dictation list and click this button on the SpeechExec Pro Dictate toolbar:  

Select a dictation in the dictation list, right-click it and select Dictation Properties from the menu: • 
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Select a dictation in the dictation list, go to the Edit menu and select Dictation Properties. • 

• 

All options listed above display the Dictation Properties dialog box which enables you to define or modify 
properties for a selected dictation. See: Dictation Properties - overview. 

You can also directly edit the dictation properties which are displayed in the dictation list. See: Edit individual 
properties in the dictation list in this topic. 

How to: edit individual properties in the dictation list 
Your dictation list displays a number of dictation properties as columns. 

Note: The dictation list columns can be configured via the View menu, Columns. See: Menus. 

You can edit these properties directly in the dictation list without opening the dictation. Proceed as follows: 

1. Enter Edit mode for the dictation property you want to change by right-clicking the required cell. 

 
Note: When you right-click a dictation which is selected in the dictation list (the whole row is highlighted in 
blue), the standard right-click menu is displayed. 

2. The Dictation Properties dialog box is displayed with the input focus on the property you want to edit. Make 
your changes; the input options depend on the type of property you want to edit. See: Types of properties. 

3. Confirm your changes by pressing ENTER. To discard your changes, press ESC. 

Whether editing of dictation properties directly in the dictation list is possible or not depends on the current state 
of the dictation: 

<Recording in progress>: No editing possible. • 

• 

• 

• 

• 

• 

<Recording suspended>: Editing allowed for the author of the dictation. 

<Transcription pending>: Both author and transcriptionist can edit properties. 

<Transcription in progress>: No editing possible. 

<Transcription suspended>: Editing allowed for the transcriptionist of the dictation. 

<Transcription finished>: Both author and transcriptionist can edit properties. 

Note: Not all dictation properties which are displayed in the dictation list are editable. The following properties 
are read-only: Special instruction, Instruction length, Created (this is the date and time when the dictation 
was created), Last modified (this is the date and time when the file was last modified), Last user (this is the 
user who made the last changes to the file), Encrypted, Delivery, DPM download date. Additionally, a 
'Locked' symbol ( ) is displayed for dictations where recording or transcription is currently in progress. This 
property is also not editable. 

Note: To edit the State property of a dictation, select the file and right-click it. Then select Change Dictation 
State from the menu. This opens a dialog box where you can make the required changes. The function for 
changing the dictation state should only be used sparingly because it may have undesired side effects. Use it 
only, for example, when SpeechExec was terminated abnormally and the dictation you were working on 
appears with the state <In progress> in the dictation list. In this case, change the dictation state to 
<Suspended> to be able to access the dictation again. 
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Folder operations 

The left pane of the SpeechExec Pro Transcribe window displays a tree view. This view shows all your currently 
visible folders. For more information about the default folder configuration, see: Tree view.  

Folders can be expanded ( ) and collapsed ( ) to show and hide potential subfolders. Additionally, you can also 
perform the following operations: 

Create a folder • 

• 

• 

• 

• 

• 

• 

Create a subfolder for an existing folder 

Rename a folder 

Change the folder path 

Delete folder 

Hide/show a folder 

Copy and move 

How to: create a folder 
To create a folder at the top level of the tree view, do the following: 

1. Right-click inside the tree view pane and select New Folder from the menu. 

 
2. Select one of the following folder types from the menu: 

General: If you select this option a standard folder is created. 
Pending: If you select this option the folder will be automatically linked to the transcriptionist's Intray and its 
contents will appear in the Intray folder. 

3. Fill in the required folder properties. 

 
All properties are mandatory; this is indicated by the ! symbol: 

Name: This is the name for the new folder. • 
• 
• 

Visible: This is the property for whether the folder will be visible or hidden in the tree view. 
Path: This is the location of the new folder. 
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Show subfolders: This is the property for whether subfolders of the new folder will be visible or hidden in 
the tree view. 

• 

• Show contents: This is the property for whether the dictations stored in subfolders of the new folder will 
be displayed in the dictation list when the new folder is selected. 

Note: The Type displays the selection made in step 2. 

4. Click OK to confirm your changes and close the dialog box. The new folder appears in the tree view. 

 

How to: create a subfolder for an existing folder 
You can create subfolders for any folders you created at the top level of the tree view (see above), and these 
existing folders: Finished, Suspended and Temp. Proceed as follows: 

1. Select the required folder, right-click it and select New Subfolder from the menu. Alternatively, go to the 
Folder menu and select New Subfolder. 

 
2. The new folder appears below the existing folder. 

 
Note: To be able to create and view subfolders below existing folders, the Show subfolders property of the 
respective folder must be set to Yes in the General Settings, Folders page. 

How to: rename a folder 
You can rename the folders in your tree view. The only exceptions are the Outbox, Sent Items and DPM folders; 
their names cannot be changed. 

1. Select the folder, right-click it and select Rename from the menu. Alternatively, go to the Folder menu and 
select Rename. 

2. Type the new name into the corresponding field of the displayed dialog box. 

3. Click OK to confirm your changes and close the dialog box. To discard your changes, click Cancel. 

How to: change the folder path 
You can change the location of where a folder is stored on your PC. The only exceptions are the Temp, Outbox 
and Sent Items folders; their paths cannot be changed. You also cannot change the path for a subfolder. 

1. Select the folder, right-click it and select Folder Properties from the menu. Alternatively, go to the Folder 
menu and select Folder Properties. 

2. In the displayed dialog box, click the 'browse' icon of the Path property field:  

3. Browse for the new location. 

Note: If the folder has subfolders, you will be asked if you also want to move the subfolders and their 
contents. 
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How to: delete a folder 
You can delete any folder that you have created yourself. Proceed as follows: 

1. Select the folder, right-click it and select Delete from the menu. Alternatively, go to the Folder menu and 
select Delete. 

2. You will be asked whether you really want to delete this folder and all its contents. Confirm the delete 
operation. 

How to: show/hide a folder 
You can decide which folders you want to have displayed in your tree view. The only exceptions are the Outbox 
and Sent Items folders; they are always visible and cannot be hidden. You also cannot hide subfolders. 

• 

• 

• 

• 

To hide a folder, select and right-click it, then select Hide from the menu. Alternatively, go to the Folder menu 
and select Hide. 

The folder is no longer visible. 

To show a folder, open the Folders page of the General Settings dialog box. Select the folder from the list 
and set its Visible property to Yes. 

The folder is visible again. 

How to: copy and move 
You can copy and move dictations between folders. Proceed as follows: 

1. Select the dictations you want to copy or move. See: Navigating the dictation list. 

2. Right-click the file or go to the Edit menu: 

Select Copy to Folder to create a copy of the dictation in the selected folder. 

Select Move to Folder to remove the dictation from the current folder and save it in the selected folder. 

Downloading DPM files 

When you connect a DPM to your PC, the DPM will appear as a folder in your Worklist tree view. The DPM folder 
name is derived from the type of DPM which is currently connected, e.g. DPM 9400.  

 

Downloading files 
How DPM files are downloaded depends on how you have configured the DPM download process. The 
configuration defines how the file download is started, whether the automatic download feature is used and which 
files will be downloaded from the DPM. 

The configuration is stored on the DPM. If you have activated the Load device settings automatically option the 
configuration is retrieved from the DPM automatically and the download process is performed accordingly. 
Otherwise the current settings in the DPM Configuration dialog box take precedence over the settings stored on 
the device. 

The download process also transfers any related files, e.g. instruction files or .xml files, to the PC. 

Important: The DPM download process takes place in two phases. The first phase is the actual file download 
where the DPM files are transferred to the Temp folder. The Temp folder is used as a temporary download 
location only before the files are moved to their actual destination folders. For more information see the sections 
which describe the default download locations for authors and transcriptionists in this topic. 

When the first phase is finished, you will receive a notification (if configured) on your screen and the DPM will 
display a 'smiley' symbol. At this stage it is safe to disconnect the DPM. 

In the second phase, any workflow-related operations are performed. This means the files are moved to their 
destination folders and subsequent tasks like file conversion or file renaming take place. 

44 



SpeechExec Pro Transcribe 

How to: Download DPM files using Keyword 1 
This example uses preconfigured settings for transferring files from the DPM to the PC and describes a basic 
automatic download configuration. Proceed as follows: 

1. On the General Settings, Download page activate the following options: 

Automatic download 
Show download progress on PC 
Sound notification when download complete 

2. On the DPM Configuration, Download Settings page activate these options: 

After connecting 
Files with Keyword 1 
Delete files on the DPM after download is finished 

For the purpose of this example configuration, let us assume that Keyword 1 has been configured with the 
author's name. So, type MyName into the field: 

 
When you now connect the DPM to your PC and SpeechExec is running, the following operations are 
performed: 

When the DPM is connected to the PC, any dictations with the Keyword assignment AuthorName are 
automatically transferred from the DPM to the PC. The files are deleted on the DPM after they have been 
downloaded. 

• 

• 

• 

You will have visual feedback about the download progress on the screen during the file transfer; when the 
download is complete, you will receive an acoustic notification. 

On the PC, the downloaded files can be found in either the Suspended, Finished or Inbox folders. For 
more information, see below. 
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How to: Select DPM files for download 
This example describes how to modify the configuration from above so that you can select which files should be 
download from the DPM. 

1. On the General Settings, Download page activate the same options as above. 

2. On the DPM Configuration, Download Settings page activate the File selection option; the other settings on 

this page remain unchanged:  

When you now connect the DPM to your PC and SpeechExec is running, the following operations are 
performed: 

When the DPM is connected to the PC, the DPM File Download dialog box is displayed. Activate the 
check box next to the files you want to download. For more information, see: DPM File Download dialog 
box. 

• 

 
When you click Download, the file transfer is started. You will have visual feedback about the download 
progress on the screen during the file transfer; when the download is complete, you will receive an 
acoustic notification. 

• 

• 

• 

• 

• 

• 

• 

The files are deleted on the DPM after they have been downloaded. 

Default download locations for authors 
When authors download DPM files, the download location is determined as follows: 

Any DPM files which have the EOL indication are downloaded to the author's Finished folder. The EOL (End-
of-Letter) indication equals the <Transcription pending> state. 

Any other DPM files are downloaded to the author's Suspended folder. Their dictation state is automatically 
set to <Recording suspended>. 

If the author has configured SpeechExec with the Set <Transcription pending> state for all DPM files 
option (General Settings, Dictation finished/Automatic download (DPM) page), any DPM files are 
downloaded to the author's Finished folder. 

Note: When you manually copy or move dictations from the DPM to SpeechExec, none of the above 
mentioned workflow settings are applied. The dictation state also remains unchanged. 

Default download locations for transcriptionists 
When transcriptionists download DPM files, the download location is determined by the preconfigured author 
profiles. These profiles are used to identify dictations and which author they belong to. 

Any DPM files for which a matching author profile can be found are downloaded to the location specified in the 
profile. In most cases, this will be the author's Finished folder which is usually mapped to one of the 
transcriptionist's Pending folders. If these files are downloaded using automatic download, the dictation state 
is automatically set to <Transcription pending>. 

Any DPM files for which no author profile can be found are downloaded to the transcriptionist's Inbox folder. 
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Workflow operations after download 
The following workflow operations may be performed when the DPM file download is finished: 

Converting the audio format; see: Automatic conversion. • 

• 

• 

• 

• 

Copying of files to the Backup folder; see: Dictation finished/Automatic download (DPM) and Archive, backup 
and purge. 

Renaming of files; see: Dictation finished/Automatic download (DPM). 

Sending of emails with dictations as attachments; see: Dictation finished/Automatic download (DPM) and 
Email profile. 

Displaying the Dictation Properties dialog box for entering missing SpeechExec information. For example, 
when you download files from DPM 9220 you can provide the author name; see: Dictation Properties - 
overview. 

Importing dictations 

When you import dictations, you browse for the dictations and define a target folder. Any additional files belonging 
to the dictation files will also be imported. Proceed as follows:  

1. Go to the File menu and select Import. 

The Import dialog box from SpeechExec is displayed. 

2. Click Browse to select the files you want to import and click Open. 

The selected files are displayed in the SpeechExec Import dialog box. 

 
3. If required, define or modify the target import folder by clicking Change. 

4. Click Import to start the import process. 

Additional information 
To add more files to your selection, click Browse again. • 

• 

• 

Activate the Delete files after importing option to delete the imported files from their original location. 

When you import dictations, any related files, e.g. instruction files or .xml files, are imported automatically. 
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General Settings 

General settings - overview 

The General Settings dialog box is where you make settings for the behavior of SpeechExec. The left pane 
contains a tree, when you select an option in the tree the available settings are displayed on the right.  

Click  on the toolbar or go to the Settings menu and select General Settings. In the General Settings 
dialog box you can make the following settings: 

 Dictation 
 Delivery 
 Update 
 Worklist 
 DPM 
 Recorder/Player 

When you have made all the settings you want on a page click Apply and open another page. When you have 
made all your settings click OK to close the dialog box. 

Important: All or some of these settings can be pre-configured and locked by your system administrator; locked 
settings are read-only. 
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Dictation 

Dictation settings - overview 

The following Dictation settings can be defined:  

Automatic conversion • 

• 

• 

• 

• 

• 

• 

• 

Dictation properties 

Encryption 

Start/suspend transcription 

Finish transcription 

Download (DPM) 

Author profiles 

User preferences 

Automatic conversion 

Here you can define the audio format of dictation files which were not created in SpeechExec and which have a 
format that only supports playback (.wma, MP3, etc.). In order to open a dictation and continue recording in these 
files they must be converted to a SpeechExec format which supports recording.   

You can also convert dictations when you have finished recording. This is useful if you need a specific format to 
process the dictation within another program. For example, if you are using a speech recognition system. 

The following options are available: 

Convert automatically when opening a dictation 
Activate this option to automatically convert the dictation file to the configured audio format (.wav or .dss 
file)when the dictation is opened. 

Click the Configure button to select the audio format you want. 

Convert automatically when finishing a dictation 
Activate this option to automatically convert the dictation file to the configured audio format (.wav or .dss file) 
when the dictation is finished. 

Click the Configure button to select the audio format you want. 

Configuring the audio format 
Click the Configure button; the Select Audio Format dialog box is displayed. The supported audio formats 
recommended for conversion are listed in the Format menu. Select the format and attributes to be applied to 
dictation files. When you select a format, the available attributes which can be selected for that format are listed 
below. 

Show all sound file formats  
Activate this option to include additional audio formats in the Format menu. 

Note: These additional audio formats are not recommended for conversion. Recording and playback is not 
supported for these formats. It might be useful to convert when finishing a dictation for later processing or if 
transcription is done within another program. 
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Dictation properties 

Here you can define when dictation properties are automatically displayed for viewing and editing.   

The following options are available: 

Before starting transcription 
Activate this option to display the Dictation Properties dialog box when you click the  toolbar button. 

When suspending a transcription 
Activate this option to display the Dictation Properties dialog box when you click the Suspend button in the 
Player module. 

When finishing a transcription 
Activate this option to display the Dictation Properties dialog box when you click the Finish button in the 
Player module. 

After DPM download 
Activate this option to display the Dictation Properties dialog box when you are downloading dictations from 
the DPM. 

Encryption 

Here you can define if dictations downloaded from the DPM should be encrypted. The passwords defined in the 
author profiles must be used to decrypt these dictations in order to work on them.  

The following options are available: 

Password 
Click this button to set a substitute password for decryption. This password will be used to decrypt dictations 
where no matching author profile can  be found. 

Always prompt for password 
If you activate this option, you must enter the password to decrypt each dictation. 

Encrypt dictations when DPM download is finished 
Activate this option to encrypt dictations when you download dictations from the DPM. 

Start/suspend transcription 

Here you can define settings for starting and suspending transcriptions.  

The following options are available: 

Start transcription program automatically 
Activate this option to have your word processing program open automatically when you open a dictation for 
transcription. 

Application path: Browse for the location of your word processing program. • 

• Command line: Enter the command line parameter which opens your word processing program. 

Note: This is an advanced feature, it is only recommended for administrators or advanced users. 

When suspending transcriptions, move to Suspended folder 
Activate this option to move dictations to your Suspended folder when you click Suspend in the Recorder 
module. If this option is not activated the dictations stay in the original location. 
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Finish transcription 

Here you can define what will happen to files when you finish transcribing a dictation.  

The following options are available: 

Delete dictation from original location 
Activate this option to delete the dictation when you click Finish in the Player module. The system does not 
save a copy of the dictation. 

Move dictation to Archive folder 
Activate this option to move the dictation to the author's Archive folder when you click Finish in the Player 
module. 

Confirm start of next transcription 
Activate this option to receive a message when you finish transcribing a dictation; you are asked if you want to 
open the next dictation and stat working on it. 

Download (DPM) 

Here you can define what happens to files which have been recorded on the DPM and downloaded to 
SpeechExec.  

The following options are available: 

Rename file with configured dictation properties 
Activate this option to include information from the dictation properties in the file name. 

Click the Configure button; the Configure Renaming Properties dialog box is displayed. 

The Configure Renaming Properties dialog box lists all file information and separators that can be included 
in the file name. Separators are punctuation marks that separate each item of information, they include: None, 
Space, Dot, Hyphen and Underscore. Separators can make the file name easier to read.  

Select the dictation properties to be included in the file name. The naming convention is also based on the 
order of the items of information; the item at the top of the list comes at the start of the file name. The Up and 
Down buttons are used to reorder the file information. 

Copy to Backup folder automatically when finishing/downloading a dictation 
Activate this option to save a copy of the DPM file in your Backup folder when it is downloaded. 

Author profiles 

Here you can define individual profiles for the authors whose dictations you transcribe (Add button). These 
profiles are used to identify dictations sent by email and which author they belong to. The author can then receive 
information about the transcription state of the dictations.  

You can also edit these profiles (Modify button) and remove any that are no longer relevant (Delete button). 

Note: The author encrypts the dictations before sending them. You need this password in order to be able to 
access the dictations. You must ensure that you have the password for every author whose dictations your 
transcribe. 

User preferences 

Here you can define user preferences.   

The following options are available: 

User name 
Displays your user name. Click Edit to change your user name. This name is displayed in the status bar of the 
main window when transcription is in progress. 

Note: When dictations are on a network this user name can be made visible in your dictation list. It identifies 
the user who worked on the dictation last. 
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Delivery 

Delivery - overview 

 The following Delivery settings can be defined:  

Send/receive • 

• 

• 

• 

Email profile 

Dial-up profile 

FTP profile 

Send/receive 

Here you can define how often dictations are automatically sent and received via email and FTP. This is relevant 
if there is no permanent connection to the mail server, for example, if you have a dial-up connection.  

The following option is available: 

Send and receive automatically 
Activate this option and select an appropriate number of minutes for the Send/receive interval. 

Email profile 

Here you can define how dictations are sent for transcription via email.   

Email (electronic mail) is the exchange of computer-stored messages by telecommunication (using Internet 
TCP/IP protocols). As well as text you can send non-text files and sound files, as attachments. Emails can be sent 
to more than one recipient. 

Here you can define the mail transfer profile. Emails can be sent and received via SMTP/POP3, Simple MAPI or 
Extended MAPI.  

MAPI (Messaging Application Programming Interface) is a Microsoft Windows programming interface that 
enables a client application to send to and receive mail from Exchange Server or a Microsoft Mail (MS Mail) 
messaging system. Microsoft applications such as Outlook, the Exchange client and Microsoft Schedule use 
MAPI. Simple MAPI provides standard email functions, while Extended MAPI adds full calendaring and workgroup 
capabilities. 

SMTP (Simple Mail Transfer Protocol) is the standard email protocol on the Internet used for sending email 
messages between servers. SMTP defines the message format and the message transfer agent (MTA) which 
stores and forwards the email. SMTP servers route SMTP messages throughout the Internet to a mail server that 
stores incoming mail messages. The messages can then be retrieved with an email client using POP3. The mail 
server uses POP3 to communicate with the user's email program. 

POP3 (Post Office Protocol 3) is a standard interface between an email client program and the mail server. POP3 
is the most common access protocol used for Internet email. POP3 stores incoming email messages until users 
log on and download them. All pending messages and attachments are downloaded when users check their 
email. 

You can create (Add button), edit (Modify button) and delete (Delete button) email profiles. 

The content and recipients of emails are defined in the Dictation settings. For more information, see: Non-
automatic delivery. 

The Default profile you select (Set As Default button) is used to send and receive dictations via email. For 
information on emails, see: Setting up your email profile. 

New Email Profile dialog box 
Select one of the following: 

Simple MAPI 
Activate this option if you have a mail system installed which supports Simple MAPI. For example, Microsoft 
Outlook Express. 

When you click OK the MAPI Settings dialog box is displayed. 
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Extended MAPI 
Activate this option if you have a mail system installed which supports Extended MAPI. For example, Microsoft 
Outlook, Novell GroupWise. 

When you click OK the MAPI Settings dialog box is displayed. 

SMTP/POP3 
Activate this option if you are using a POP3 server for incoming mail and an SMTP server for outgoing mail. If 
you select this option no email client is involved. Communication is done directly with the POP/SMTP server. 

When you click OK the POP/SMTP Settings dialog box is displayed. 

Lotus Notes 
Activate this option if you have Lotus Notes installed. 

Novell GroupWise 
Activate this option if you have GroupWise installed. 

New profile name 
Enter a name for the email profile and click OK. 

MAPI Settings dialog box 
You can make the following settings for sending and receiving emails via MAPI: 

Profile 
Select the email profile (in some cases this can be the name of the mail client you are using). 

Note: The email profile is generally created during the installation and configuration of the mail client's MAPI 
subsystem.  

Address prefix 
Select the prefix of the email address. This is the internal prefix of the email address; some mail clients require 
that this prefix is specified. For example, 'SMTP' if your MAPI client is Outlook or Outlook Express, 'NGW' if it 
is Novell Groupwise or 'LOTUS' in case you are using Lotus Notes. 

Password 
Enter the password for logging on to the mail client. 

POP/SMTP Settings dialog box 
You can make the following settings for sending and receiving emails via SMTP/POP3: 

SMTP settings 

Server 
Enter the name of the server. This can also be the IP address. 

User 
Enter the user name for logging on to the SMTP server. 

Password 
Enter the password for logging on to the SMTP server. 

Sender's address 
Enter your email address. 

Port number 
Enter the port number which identifies the SMTP service. 

Some services or processes have conventionally assigned permanent port numbers. Click the Default 
button to select this number automatically. 

Use SMTP authentication 
Activate this option if your SMTP server registers legitimate sender addresses for outgoing mail. 
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POP settings 

Server 
Enter the name of the server. This can also be the IP address. 

User 
Enter the user name for logging on to the POP server. 

Password 
Enter the password for logging on to the POP server. 

Port number 
Enter the port number which identifies the POP service. 

Some services or processes have conventionally assigned permanent port numbers. Click the Default 
button to select this number automatically. 

Lotus Notes Settings dialog box 
You can make the following settings for sending and receiving emails via Lotus Notes 

User 
Enter the user name for logging on to Lotus Notes. 

Password 
Enter the password for logging on to Lotus Notes. 

GroupWise Settings dialog box 
You can make the following settings for sending and receiving emails via Novell GroupWise. 

User 
Enter the user name for logging on to Novell GroupWise. 

Password 
Enter the password for logging on to Novell GroupWise. 

Dial-up profile 

Dial-up uses a modem to connect to the internet. A dial-up connection is established and maintained for a limited 
time duration. Alternatively, your system might have a dedicated connection (phone-line), which is continuously in 
place. A dial-up connection is initiated by your PC's modem or other device.  

This setting is relevant for users who must dial up the Internet to send emails. 

Use dial-up connection 
Activate this option to enable your dial-up connection. 
Only activate this option if you are using a modem. Do not activate this option if you have a permanent 
Internet connection. 

The following settings are only available if the above option is activated. 

Dial-up profile 
Select your pre-configured profile. 

Note: The Dial-up profile is created outside SpeechExec (go to the Start menu, Settings, Control Panel and 
double-click Network and Dial-up Connections). You must configure your Dial-up profile before making 
these settings in SpeechExec. 

Confirm before connecting 
Activate this option to receive a message before a dial-up connection is established. You must confirm your 
action. 

This setting ensures that you only connect to the Internet when you really want to, therefore avoiding, for 
example, extraneous telephone costs. 

Hang up automatically when sending/receiving/updating is finished 
Activate this option to have SpeechExec automatically terminate the connection to the Internet. No message is 
displayed before this action is performed. 

Important: Please note that if you hang up automatically you might lose your connection unexpectedly if, after 
your dictations have been sent, you want to remain connected to the Internet in order to perform activities 
outside SpeechExec. It is also possible that if you activate this option SpeechExec could terminate an Internet 
connection made by another program, for example, Microsoft Outlook. 

54 



SpeechExec Pro Transcribe 

Dial automatically before checking for new messages/notifications 
Activate this option to automatically connect to the Internet via SpeechExec. If this setting is not activated, it is 
not possible to send emails unless you have a dial-up connection via another program (outside SpeechExec). 

Do not download messages larger than 
Enter the number of kilobytes based on what your system can process. This setting prevents you receiving 
emails larger than your system can easily handle. Downloading very large messages can affect the 
performance of your PC. 

FTP profile 

Here you can define how dictations are uploaded and downloaded for transcription via FTP.   

File Transfer Protocol (FTP) is a standard Internet protocol for exchanging any type of file between computers on 
the Internet (using TCP/IP protocols).  

You can create (Add button), edit (Modify button) and delete (Delete button) FTP profiles. For information on 
FTP, see: Setting up your FTP profile. 

The Default profile you select (Set As Default button) is used to download dictations via FTP. 

New FTP Profile dialog box 
Here you give the FTP profile a name which identifies it on the FTP page of the General Settings dialog box. 
When you click OK, the FTP Settings dialog box is displayed. 

FTP Settings dialog box 
FTP settings 

FTP server 
Enter the name of the server. This can also be the IP address. 

Main path 
Enter the path of the FTP server.  

User 
Enter the user name for logging on to the FTP server. 

Password 
Enter the password for logging on to the FTP server. 

Port number 
Enter the port number which identifies the FTP service. 

Some services or processes have conventionally assigned permanent port numbers. Click the Default 
button to select this number automatically. 

Proxy settings 

User proxy server 
Activate this option to use a proxy server. A proxy server in necessary if the FTP server is outside the 
firewall (if one is installed). 

Proxy server 
Enter the name of the server. This can also be the IP address. 

Port number 
Enter the port number which identifies the proxy service. 

Some services or processes have conventionally assigned permanent port numbers. Click the Default 
button to select this number automatically. 

Delete dictation files from FTP server after download 
Activate this option to delete dictations from the FTP server after they have been downloaded. 
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Updates 

Update - overview 

 The following update settings can be defined:  

SpeechExec software - This includes updates for all components of SpeechExec. • 

• 

• 

• 

• 

DPM firmware 

Proxy server - If the update mechanism does not work and SpeechExec cannot connect to the Internet, you 
may need to configure a proxy server. 

Update mechanism 
SpeechExec updates are stored on a web server. Your SpeechExec installation includes an update configuration 
file which scans this web server for updates The software update mechanism is triggered if the locally installed 
version of SpeechExec and the server version are different. The size of an update can vary from 0.5 MB to 40 
MB. 

Note: SpeechExec Dictate, SpeechExec Pro Dictate and SpeechExec Pro Transcribe each have individual local 
and server update configuration files. The updates for the different programs are provided at different web server 
locations.  

For updating the DPM firmware, the local configuration file is only for defining the web server location. The 
configuration file on the server contains the corresponding DPM firmware version. The local DPM firmware 
version is obtained directly from the DPM and not stored in the local configuration file. The firmware update is only 
triggered if a DPM is connected to the PC. 

Proxy server 
SpeechExec must access the Internet Explorer proxy settings. However, if your network administrator has 
configured Internet Explorer to use an automatic configuration script, or if you use another Internet browser, 
SpeechExec will not be able to access the Internet Explorer proxy configuration. In this case, you must configure 
a proxy server. 

Before you configure a proxy server, you need to know: 

The proxy server address. 

The proxy server port number. 

Your network administrator can provide this information. 

About the update 
Before downloading the update you can find out what changes/features are included. If program updates are 
available a dialog box is displayed from which you can view the SpeechExec Readme file. This file contains all 
relevant information on the update. You can then decide if you want to download it. 

No system or user settings are lost when updating. 

Once you have a applied an update to the SpeechExec system it is not possible to undo the update (downgrade 
to an earlier version). If you want your previous version, you must uninstall SpeechExec and reinstall the previous 
version. 

SpeechExec software 

Here you can check for available program updates.  

Check for updates automatically 
Activate this option to automatically check for available SpeechExec software updates. Select how often the 
automatic check should be executed. 

Check Now 
Click this button at any time to manually check for available SpeechExec software updates. 

Software update process  
The software update process has the following steps: 

1. If you have made settings to automatically check for updates, SpeechExec checks for available updates when 
the program is started. 

2. If available program updates are identified, a message is displayed asking if you want to download the update. 
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3. If you select Yes, a progress dialog box is displayed during the download process. The software update will be 
downloaded to the local Temp/SpeechExecUpdater folder. 

4. A message is displayed asking if you want to install the update. 

5. If you select Yes, SpeechExec is shut down and the update is applied to the relevant program files. The local 
update configuration file is also replaced.  

If you select No, you can continue working. If you want to install the update later, browse for your local 
Temp/SpeechExecUpdater folder and double-click the .exe file to apply the update manually. 

6. You may be asked to restart the PC. 

For information on how the update mechanism works, see: Update - overview. 

DPM firmware 

Here you can check for available DPM firmware updates.  

Firmware is that part of the software which has been programmed into the DPM device and can be upgraded, via 
SpeechExec, when the device is connected to the PC. 

Check for updates automatically 
Activate this option to automatically check for available DPM firmware updates. Select how often the 
automatic check should be executed. 

Check Now 
Click this button at any time to manually check for available DPM firmware updates. The DPM must be 
connected to the PC. 

Firmware update process  
The firmware update process has the following steps: 

1. If you have made settings to automatically check for updates, the SpeechExec program checks for available 
updates when a DPM is connected to the PC. 

2. If available firmware updates are identified, a message is displayed asking if you want to download the 
update. 

3. If you select Yes, a progress dialog box is displayed during the download process. 

4. A message is displayed asking if you want to install the update. 

5. If you select Yes, the new firmware version is copied to the DPM 2 USB mass storage device. 

6. A message is displayed saying that the DPM must be disconnected for the device to update to the new 
firmware. 

Note: DPM firmware update for DPM 9400 (or lower) is only supported if the DPM already has DPM firmware 
version 2.30 or higher. 

For information on how the update mechanism works, see: Update - overview. 

Proxy server 

Here you can update your proxy server settings.  

Use proxy server 
Activate this option to use a proxy server when checking for updates. 

Note: The proxy server is required to be able to connect to the web server where the updates are located. 

Proxy server 
Enter the name of the server. This can also be the IP address. 

Port number 
Enter the port number which identifies the proxy service. 

Note: Your network administrator can provide this information. 

For information on how the update mechanism works, see: Update - overview. 

57 



SpeechExec Pro Transcribe 

Worklist 

Worklist settings - overview 

 The following Worklist settings can be defined:  

Purge • 

• 

• 

• 

• 

• 

• 

• 

File operations 

Notification 

Dictation list 

Shortcuts 

Visibility 

Folders 

Licensing 

Purge 

Here you can define that dictations are automatically deleted from the system. The purge process permanently 
deletes dictations in your Archive folder which are older than the specified period of time.  

The following option is available: 

Purge dictations older than 
Select an appropriate number of days. Dictations which have been in the Archive folder longer than this are 
permanently deleted, either automatically or manually. 

Purge automatically 
Activate this option to automatically purge dictations in your Archive folder older than the selected number of 
days. 

Purge manually 
Activate this option to manually purge dictations in your Archive folder, older than the selected number of 
days, when you click the Purge Now button. 

File operations 

Here you can define general file settings.   

The following options are available: 

Resolve file name conflicts automatically 
Activate this option to resolve file name conflicts automatically. If you do not activate this option you will 
always receive and overwrite message if 2 file names are identical. 

A file name conflict occurs when the names of the files are identical but the dictations are different. 

It is possible in a network of many users, perhaps sharing folders or when a dictation is copied rather than 
moved to the Local Work folder, for file name conflicts to arise. To resolve this conflict the name of the newer 
file is appended with the suffix: _0002. For example, your file naming convention is MyName001.dss; the file 
which is more advanced in the workflow (or if both are in the same phase, the file which was updated most 
recently) becomes MyName001_0002.dss. 

Note: If you manually copy or move a dictation (Edit menu: Move to Folder, Copy to Folder) the system 
cannot automatically resolve file name conflicts. If you attempt to copy or move a file to a folder where a 
dictation with the same file name is stored, you will be asked if you want to overwrite the existing dictation. 

Move deleted files to the Recycle Bin 
Activate this option to move files to the Recycle Bin when deleting. When you delete a dictation the file is not 
permanently deleted. It can be recovered from the Recycle Bin. This setting is only applied to files saved on 
your local hard disk which are manually deleted. 

58 



SpeechExec Pro Transcribe 

Notification 

You can configure how you want to be notified about new dictations in your Intray folder. Your Intray folder 
organizes all your input folders into one simulated 'overview' folder.   

The following options are available: 

Notification on 
Activate this option to receive notification when a dictation has arrived. Select one of the following: 

Urgent dictations only: Activate this option to receive notification only when an urgent dictation has 
arrived. 

• 

• 

• 

Note: Dictations classified as urgent depend on the priority setting made on the Dictation list page. Any 
dictation with a priority value equal to or higher than the priority setting is classified as urgent and is 
displayed in the dictations list with a different color. 

Visual notification: Activate this option to receive a message when a dictation has arrived. 

Sound notification: Activate this option to receive an audio signal when a dictation has arrived. You can 
select the sound file you want to have. 

Reminder on 
Activate this option to receive a message that dictations are ready to be worked on. Select how often this 
message should be displayed. 

Close notification/reminder message automatically 
Activate this option to close the notification/reminder message automatically; you will not have to manually 
close the message. Select how long this message should be displayed for before it is closed automatically. 

Dictation list 

Here you can define settings for your dictation list.  

The following options are available: 

Refresh network folders automatically 
Activate this option to automatically update the information in your dictation list. 
Select how often the information is refreshed. 

Note: In a Windows network dictations are immediately updated. Folders saved on your local drive are also 
refreshed immediately. 

Priority 
Select the level for color-coding dictations displayed in your dictation list. 

Dictations with this value or higher are color-coded; they are displayed as urgent dictations. This means that 
they appear in the dictation list with a different color than lower priority dictations. The Priority you set 
determines which dictations have this color-coding. For example, if you set a Priority of 10, dictations with a 
priority value of 10 or higher are listed with this color-coding. 

Display tooltips 
Define for how long a tooltip is displayed when you hover your mouse over a user interface element. 
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Shortcuts 

Here you can define shortcuts for actions using combinations of keys on your keyboard.  

The Keyboard shortcuts list shows the keystroke combinations and actions that have already been assigned as 
well as actions that can be assigned shortcuts.  

To create a new shortcut, select the action and with the focus in the field below press the keystroke combination 
and click Assign. 

 
To delete a shortcut, select the shortcut from the list and click Remove. You can then assign a new key 
combination to this action if necessary. 

You cannot change the default keyboard shortcuts. For a description of the default keyboard shortcuts, see: 
Keyboard shortcuts. 

Actions 
The following actions can be assigned keyboard shortcuts: 

Activate and deactivate all SpeechExec assigned function keys. When you deactivate the SpeechExec 
assigned functions, the default function of the key is re-instated. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Start and stop recording. 

Start and stop recording a special instruction. 

Start and stop recording a spoken instruction. 

Go to the previous spoken instruction. 

Go to the next spoken instruction. 

Stop the current action. 

Fast forward through the dictation. 

Fast rewind through the dictation. 

Finish the dictation. 

Suspend the dictation. 

Close the dictation. 

Open the next dictation for transcription. 

Start and stop recording of a special instruction. 

Switch between Insert and Overwrite mode. 

Reactive playback: playback starts and lasts for the specified length of time. Different keystrokes can be 
assigned for different lengths of time. 

Increase and decrease the level of volume, speed and tone in increments of 10%. 
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Visibility 

Here you can define what you see when you are working.  

The following options are available: 

Show Worklist while Recorder/Player is active 
Activate this option to show the Worklist module when you are working with the Recorder module. The focus is 
on the Recorder module but you can see the Worklist module in the background. 

Show Worklist when connecting DPM 
Activate this option to automatically open the Worklist module when you connect your DPM to the PC. 

Folders 

Here you can define the folders that appear in your tree view.  

The Folder settings section lists the name and location of all folders in your tree and also the folders which are 
currently hidden. Select a folder to view and edit its properties in the Folder properties section below. 

Click the New button to create a new folder. Give the folder a name and define the folder properties. 

Note: You can only delete folders you have created. To delete a folder, select it in the list and click the Remove 
button. 

Folder properties 
The icon to the right of each field indicates how the property can be edited. 

Type: The type of folder. • 

• 

• 

• 

• 

• 

Name: The name of the folder. 

Visible: Indicates (Yes/No) if the folder is visible in your tree view. 

Path: The location of the folder. 

Show subfolders: Indicates (Yes/No) if subfolders of this folder will be visible in your tree view. 

Show all dictations: Indicates (Yes/No) if the contents of the subfolders should be displayed when viewing 
the root folder. 

Licensing 

Here you enter the host name of your license server when using site licenses.  

User license server 
Activate this option to be able to use the site license server. 

Server 
Enter the host name of the license server or the IP address of the PC. 

For information on licensing, see: Licensing and dongle  
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DPM 

DPM settings - overview 

The following DPM settings can be defined:  

Download • 

• 

• 

Path 

Program options 

Download 

Here you can define options for downloading files from your DPM.  

The following options are available: 

Automatic download 
Activate this option to enable files to be downloaded automatically from your DPM. This means that fully 
configurable automatic file transfer of dictation files from your DPM to the PC takes place. Depending on your 
transfer settings, the preconfigured settings made on the device or in the DPM Configuration dialog box take 
precedence when the files from the DPM are transferred to the PC. 

If this option is not enabled, no file transfer is initiated; you must transfer files from the DPM manually. 

Show download progress on PC 
Activate this option to display a progress bar on the PC while files are transferring from the DPM to the PC. 

Sound notification when download complete 
Activate this option to receive an acoustic notification when the transfer of DPM dictation files to the PC is 
finished. 

Select sound 
Browse for the sound file you want as notification. 

Path 

Here you can define the path to the drive which has been assigned during the installation of the DPM. The files 
are still on the DPM and not on the PC.  

Automatic 
Activate this option if you want the path for the DPM to be automatically detected. 

Manual 
Activate this option to select where the DPM files will be saved. This is not recommended and should only be 
activated if the program is unable to find the DPM, for example, in a Citrix environment. 

Path 
This is the location for the DPM files on the PC. The path for the DPM can be assigned manually by typing the 
path into the corresponding field or by clicking the Browse button. 
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Program options 

Here you can define options for working with your DPM.  

The following options are available: 

Device type 
Displays the type of DPM which was last connected to the PC and enables you to select a different type. If the 
device is still connected, selecting a different type is not possible. 

When a different DPM type is connected, this setting is changed automatically to the DPM which is connected. 

Note: This option also enables you to create configuration files for different types of DPMs without having the 
device connected to the PC. It is also possible to create one configuration file with all possible settings for all 
types of DPM devices. If this file is used for configuring different devices with different functions, only the 
supported settings are transferred to the device. 

Synchronize DPM time with PC time 
Adjusts the time displayed on the DPM with the time of the PC when the DPM is connected to the PC. 

Transfer DPM settings automatically when connecting DPM 
Automatically retrieves the DPM configuration which is stored on the device when the DPM is connected to 
the PC. The settings from the device overrule the device-specific settings in the program. 
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Recorder/Player 

Recorder/Player settings - overview 

The following Recorder/Player settings can be defined:  

Options • 

• 

• 

• 

Appearance 

Playback 

Foot Control 

Options 

Here you can define options for working with the Player module.  

The following options are available: 

Spoken instructions on 
Activate this option to be able to record and work with spoken instructions. All Player module options for 
controlling spoken instructions are available, such as menu commands. 

The following buttons are also available in the Player module: 

Record Spoken Instructions 
Previous Spoken Instruction 
Next Spoken Instruction 

If this option is not activated, working with spoken instructions is not possible. 

Special instructions on 
Activate this option to be able to record and work with special instructions. All Recorder module options for 
controlling special instructions are available, such as menu commands. 

The following buttons are also available in the Player module: 

Record Special instructions 
Play Special Instructions 
Delete Special Instruction 

If this option is not activated, working with special instructions is not possible. 

Use temporary copy when working on dictation 
Activate this option to use your Temp folder when working on dictations with the state <In progress>.  

If this option is not activated, the dictation you are working on is in your Suspended folder on the network. 

Note: It is recommended that you activate this option in order to avoid any loss of data caused by problems 
with the network. The Suspended folder is on the network and creating dictations locally ensures that no 
information is lost if problems occur. 
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Appearance 

Here you can define how the Player module looks.  

The following options are available: 

Display mode 
Select, from the following, how the Player module should be opened: 

Expanded mode: The full Player module window is opened: • 

 
Compact mode: The Player module is opened as a small toolbar: • 

 
For more information on these modes refer to the SpeechExec Recorder & Player Online Help. 

Always on top 
Activate this option to have the Recorder module always displayed on top when it is opened from the Worklist 
module. This means that another program, such as Microsoft Word, can have the focus but you can still see 
the Recorder module. 

Show dictation properties in the Recorder/Player window 
Activate this option to be able to view dictation properties in the Player window. 

Click the Configure button; the corresponding dialog box lists the dictation properties that can be displayed in 
the Player window. Activate the corresponding check box to have that property displayed. The Move Up and 
Move Down buttons can be used to reorder the information in the Player window. 

The dictation properties information is displayed beneath the control and positioning buttons in the Player 
window: 

 

Playback 

Here you can define options for playing back dictations.  

The following options are available: 

Acoustic feedback 
Activate this option to be able to hear your recording during fast forward or rewinding (you will not be able to 
understand it, but you will be able to notice pauses and differentiate between sections of speech). 

Winding speed 
Set the speed for rewinding and fast forwarding through your recordings. 

Auto-backspace 
Activate this option and specify the number of seconds to rewind a sound file when restarting playback. 
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Foot Control 

Here you can define options for working with your Foot Control.  

The following options are available: 

Hands-free dictation mode 
Activate this option to use the Foot Control for recording dictations. 

Serial port (COM) 
Select the port where the Foot Control is connected. 
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Dictation Properties 

Dictation Properties - overview 

The Dictation Properties dialog box lists all properties relating to the selected dictation on the following tabs:  

Dictation tab 
File tab 
Audio tab 

Properties can be defined when creating a dictation and, if necessary, edited at various stages of the workflow. 
Each property is displayed as a column in the dictation list. 

Default properties can be defined in your user preferences. This way you ensure that many of the property fields 
are automatically filled in by SpeechExec when you create a new dictation.  

How you edit dictation properties depends on the type. Some properties can be selected from a menu or a 
calendar, or you must type the information in to the field. For information on the different types of property, see: 
Types of properties. 

You can use the Copy button to copy the dictation properties of the selected dictation to another program. 

Displaying the dialog box 
To display the Dictation Properties dialog box, select a dictation in your dictation list and do one of the following: 

Go to the Edit menu and select Dictation Properties. • 

• Click on the toolbar. 
Right-click the dictation in the Worklist and select Dictation Properties. • 

Displaying properties 
You can define which properties should be applied to dictations. In the Dictation Properties dialog box click 

. In the corresponding dialog box activate a check box to add the dictation property and deactivate a check 
box remove the dictation property. Click OK to accept the changes and close the dialog box. The selected 
properties are displayed in the Dictation Properties dialog box. 

Dictation tab 

This tab of the Dictation Properties dialog box contains information about the dictation. The following default 
dictation properties are available:  

Notification: When notification is to be sent at which phase and state change, for example, when the phase 
becomes <Transcription finished>. You can select more than one option here. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Attach file to notification: Indicates if files (dictation files or documents) should be attached to the notification 
when transcription is finished. 

Email address for notification: The author's email address, notifications are sent to this address. 

Author: The name of the person who created the dictation. For DPM files, this is the Keyword 1 definition. 

Revision author: The name of the person who works on the dictation file and closes the file, with the 
Suspend or Finish buttons in the Recorder module, but did not create the dictation. 

Title: Descriptive text for the dictation. 

Keyword: Text which can be used as a search string in a workflow environment. 

Comment: Additional information on the dictation, such as instructions for transcription.  

Priority: Indicates the priority setting of the dictation file. The default range is 0 - 15, with 0 being the lowest 
priority and 15 the highest. 

Note: If the dictation file is a DPM file, the priority values are either 0 (no priority) or 8 (priority). 

Keyword 1-5 (DPM): Content strings of the Keywords on the DPM. The program is delivered with the 
following SpeechExec dictation properties associated with DPM Keywords: 

Keyword 1 - Author 
Keyword 2 - Keyword (SpeechExec) 
Keyword 3 - Comment 
Keyword 4 - Title 
Keyword 5 - No SpeechExec dictation property is associated with this Keyword. 

67 



SpeechExec Pro Transcribe 

Label 1-2 (DPM): The user-defined label strings which were entered on the DPM. • 

• 

• 

• 

• 

• 

• 

• 

• 

Barcode: The barcode string of the corresponding dictation file. 

Instruction length: The length of the instruction file in HH:MM:SS. 

Dictation length: The length of the dictation file in HH:MM:SS. 

Created: The date and time when the dictation file was created in YYYY/MM/DD HH:MM:SS (year/month/day 
hours:minutes:seconds; this is not the time the dictation file was first saved). 

Last modified: The date and time of the last changes to the dictation file in YYYY/MM/DD HH:MM:SS. 

Phase and State: The phase and state the dictation is currently in. 

Last user: The name of the user who has worked on the dictation most recently (this can be either an author 
or a transcriptionist). If a dictation is suspended, only this user can reopen the dictation and continue working. 

Encrypted: Indicates (Yes/No) if the file is encrypted, this icon is displayed in your dictation list: . Before 
playback can start, the file must be decrypted into a local temporary folder. 

Email/FTP: The method the dictation is delivered for transcription. Indicates if the file contains email 
information, this icon is displayed in your dictation list: or if the file contains FTP information, this icon is 
displayed in your dictation list: . Click the icon to view this information.  

• 

• Locked: Indicates (Yes/No) if a dictation is currently being worked on by a user, this icon is displayed in 
your dictation list: . For example, if the phase and state is <Dictation in progress> or <Transcription in 
progress>. 

Instruction file: Indicates (Yes/No) if the author has recorded a special instruction for the corresponding 
dictation. This icon is displayed in your dictation list:  

• 

Dictation name: The name of the dictation file. • 

File tab 

This tab of the Dictation Properties dialog box contains information on the properties of the dictation file; this 
information is provided by the file system.   

The following file properties are available: 

File attributes: The attributes of the file, for example, archive, read-only, hidden. • 

• 

• 

• 

• 

File size (bytes): The length in bytes of the dictation file. 

Creation time: The date and time when the dictation file was created in DD.MM.YYYY HH:MM:SS 
(day.month.year hours:minutes:seconds). This is not the time the dictation file was first saved. 

Last access time: The date and time of the last time the dictation file was opened in DD.MM.YYYY 
HH:MM:SS. 

Last write time:The date and time of the last changes to the dictation file in DD.MM.YYYY HH:MM:SS. 

Note: These properties are read-only. 

Audio tab 

This tab of the Dictation Properties dialog box describes the audio format of the dictation file. If the file is 
converted some properties will be changed.   

Note: It is identical to the WAVEFORMATEX structure (Waveform-audio data) of Microsoft Windows which 
defines the audio format used for sound files. These properties may not fully describe dictation files of other audio 
formats. 

The following audio format properties are available: 

Format name: The name of the audio format. For example, Philips CELP. • 

• 

• 

Format tag: The type of audio format. This is an integer value, for example, 288 for Philips CELP. 

Average bytes/sec: The required average rate of data transfer, in bytes per second. This can be, for 
example, calculated per the specification of the format. Philips CELP, which has an average per second of 
2400, produces 2400 bytes per second. This is necessary to calculate the size of the file from the given audio 
length. 
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Bits/sample: The bits per sample for the Format tag. For example, 8 or 16.  • 

• 

• 

• 

• 

Block align: The minimum atomic unit (in bytes) of data for the Format tag.  

Channels: The number of channels in the audio data. For example, one for mono. 

Extra bytes: The size, in bytes, additionally required to specify the format (the additional size in bytes of the 
wave structure). 

Samples/sec: The sample rate in samples per second (hertz) that each channel should be played or 
recorded. For example, 8.0 kHz, 11.025 kHz, 22.05 kHz or 44.1 kHz.  
The sample rate is the number of samples of a sound that are taken per second to represent the event 
digitally. The more samples taken per second, the more accurate the digital representation of the sound can 
be. For example, Philips CELP: 16.000. 

Note: These properties are read-only. 

Types of dictation properties 

All information relevant to SpeechExec dictations is stored in the form of properties. Each property has a field 
name and belongs to one of several types (see below). These fields can contain read-only information, which 
cannot be altered, and properties which can be changed by you.  

Mandatory fields  
!  

An exclamation mark to the left of a property means that it is mandatory and a value must be filled in. 

Field types  
All properties which can be edited have an icon to the right of the field. 

 
Text entry field – information consisting of letters and numbers. 

For example, a note to the transcriptionist. 

 
Value range field - information consisting of numbers only. 

For example, a priority level. 

 
Single selection list - information appears as a drop-down list; only one selection is possible. 

For example, Yes/No indication. 

 
Multiple selection list - information appears as a drop-down list; more than one selection is possible. 

For example, Notification. 
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DPM 

DPM - overview 

You can create dictations on a DPM (Digital Pocket Memo) and then download these dictations into the 
SpeechExec workflow, see: DPM File Download dialog box.  

SpeechExec assists you in configuring the DPM (Digital Pocket Memo) for your everyday work, see: DPM 
Configuration  - overview. 

For novice users SpeechExec provides a wizard to help in configuring the DPM according to your preferences. 
The wizard takes you through the configuration process with detailed information about each step, see: DPM 
Wizard - overview. 

DPM File Download dialog box 

The DPM File Download dialog box is displayed when you connect your DPM to the PC (depending on the your 
download settings). Dictations saved on the DPM are listed. These dictations can be downloaded into the 
SpeechExec workflow.  

For information on Configuring your DPM, see: DPM Configuration - overview. 

If you are a novice DPM user and need assistance to configure your DPM, see: DPM Wizard - overview. 

For information on downloading DPM files, see: Downloading DPM files. 

Select the dictations to be downloaded and click the Download button. The dictations are saved to the 
appropriate folder. For example, dictations with the <Transcription pending> state are located in your Finished 
folder and dictations with the <Recording suspended> state are located in your Suspended folder. 

Right-click menu 
When you right-click a file below Available files the following menu commands are available: 

Select All for Download 
Selects all the dictations listed. 

Deselect All for Download 
Deselects all the dictations listed. 

Toggle All for Download 
Removes the check mark from selected dictations and selects dictations which were not selected. The 
download status of all dictations in the list is changed. 

Download Selection 
Marks the selected dictation for download.  

Undo Selection for Download  
Removes the check mark from the selected dictation. 

Toggle Selection for Download 
Removes the check mark from the selected dictation or, if the dictation was not selected, selects it. 

Note: You can use the CTRL and SHIFT keys to select more than one dictation. 

Playback 
You can play back the files on your DPM before downloading them. 

 Click this button to play back the selected dictation. Click the button again to stop playback. 

 Click this button to play back the special instruction associated with the selected dictation. Click the button 
again to stop playback. 
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DPM Configuration 

DPM Configuration - overview 

Click on the toolbar or go to the DPM menu and select DPM Configuration.  

The DPM Configuration dialog box enables you to configure the DPM (Digital Pocket Memo) according to your 
individual preferences for everyday work. You can make specific settings for the device itself and have full control 
over the file transfer between the DPM and the PC. 

The following settings can be made:  

General: Provides options and settings for the behavior of the DPM. For example, to turn the device beep on 
and off, to choose the time format, to select the preferred DPM display appearance etc. 

• 

• 

• 

• 

• 

• 

Advanced: Provides advanced options and settings for the behavior of the DPM. For example, to set the 
number of additional user-defined labels on the DPM, to specify a mandatory user input option, etc. 

Keyword Definition: Enables the creation of up to 5 Keywords with strings for their usage and contents; the 
number of supported Keywords depends on the type of DPM device. 

Protection: Prevents users from changing the device configuration on the device. 

Download Settings: Enables users to make settings for the file transfer from the DPM to the PC. 

Keyword Options: Enables users to make the setting for linking sets of Keywords and/or scanning barcode 
information into keywords. For DPM 9450 this page enables to define the input options for the available 
Keywords. 

When you open another page the settings you have already made are remembered and all settings are saved 
when you click OK. 

For information on working with DPM files, see: Downloading DPM files 

General (DPM Configuration) 

The General page of the DPM Configuration dialog box provides various options for setting the behavior of the 
DPM. These options are:  

Recording format 
This setting defines whether files on the DPM will be created using the SP (Standard Play) or the LPm (Long 
Play mobile) recording format. 

Appearance 
This setting defines the screen layout of the DPM display. The Standard display option uses larger symbols. 
The Advanced display option uses smaller symbols and shows more detailed information about the current 
dictation; this is the default option with which the DPM is delivered. 

Note: This setting is not available for DPM 9220. 

Microphone sensitivity 
This setting defines the audio input level for the DPM's built-in microphone. 

File name 
This setting defines how the file names of DPM recordings are created. The Keyword 1 option creates a file 
name based on the predefined Keyword 1. The Prefix option enables you to define a prefix string with up to 4 
characters. 

Example: File name creation with Keyword 1 
Keyword 1 is Author (as defined in the Keyword 1 usage; see: Keyword Definition tab). The entries for the 
keyword usage, this means the defined content strings, are a selection of author's names: Jones, Singh, 
Watson. 
Author Watson selects the respective author name on the DPM. The DPM generates this file name: 
Wats001.dss 

Example: File name creation with prefix string 
Author Watson defines the prefix string Memo. The DPM generates this file name: Memo001.dss 

Note: If a number was specified for the creation of the next dictation file (see below), this number is used. If 
the dictation file has instructions recorded for it, this is indicated in the file name in the following way: 
Wats001i.dss. 
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Dictation number 
This setting defines the numbering sequence for dictation sound files recorded on the DPM. 
The Continue existing sequence option leaves the current numbering sequence on the DPM unchanged. 
The Start new sequence option enables you to define a new numbering sequence. The number which is 
entered in the field will be used for the next file recorded on the DPM. This resets the counter not only for the 
next file but also for all subsequent files. 

AM/PM time format 
This setting defines that the time is displayed in the 12-hour time format with AM/PM symbols on the DPM. 
Otherwise, the time is displayed in the standard 24-hour format. 

Note: The date is always displayed in the YYYY-MM-DD format. 

Special instructions / Spoken instructions / Index 
Depending on the DPM which is connected, this setting defines that the DL/VC button on the DPM records a 
special instruction or a spoken instruction or sets an Index marker when it is pressed during recording. This is 
the DL/Index button on the DPM 9360 and the DL/S.INSTR. button on the DPM 9400. 

Note: The functionality for recording spoken instructions is only available with DPM 9400, DPM 9450, Philips 
9750 and Philips 9850. For more information about recording spoken instructions with these devices, refer to 
their User Manuals. 

Note: Pressing the DL button on the DPM when the device is connected to the PC starts transferring the files 
from the DPM to the PC. 

Note: If you press the button for less than 300 ms (milliseconds) no spoken instruction is created. If you press 
the button for less than 500 ms, a spoken instruction with zero length is created; this means that an Index 
marker is set. 

Device beep 
This setting defines that the DPM beeps when specific operations take place. 

Voice-activated recording 
This setting defines that the voice-activated recording mode is used. 
Voice-activated recording mode is a convenient feature for hands-free dictation. When voice-activated 
recording is enabled, the DPM is in Record Standby; recording will start automatically when the input level 
exceeds a certain threshold (this is usually when the author starts speaking). Recording stops automatically a 
few seconds after the author stops speaking and restarts automatically when the author starts speaking again. 

Record into one file only 
This setting defines that only one dictation sound file is created. 
Activating this option changes the behavior of the DPM. Any recording you make is stored in a single file, 
instead of separate files for different subjects; this behavior is similar to recording on a tape with an analog 
device. 

Record notification beep 
This setting defines that the DPM beeps when recording is possible. 
Activating this option means that you must wait until you hear a beep before you start recording; this behavior 
is similar to the behavior of standard voice mail machines. 

Advanced 

The Advanced page of the DPM Configuration dialog box provides various enhanced options for setting the 
behavior of the DPM. These options are:  

Additional user-defined labels 
Set the counter to enable DPM users to enter 0, 1 or 2 additional user-defined labels on the DPM. If the 
counter is set to 0, the feature is disabled. 

Note: This feature is not available with DPM 9220. 

Recording time 
Select the Used time option to have the used-up recording time displayed on the DPM. Select the Remaining 
time option to have the remaining recording time displayed on the DPM. The recording time is only available if 
the Advanced display option is enabled, see: General (DPM Configuration). 

Note: This feature is not available with DPM 9220. 

Select which type of mandatory information DPM users have to provide when making recordings. 

None: Disables the mandatory user input feature. 
Keyword: All required predefined Keywords must be selected when a new recording is started. 
Special instruction: A special instruction must be recorded when a new recording is started. 
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User-defined label: The specified number of user-defined labels must be entered when a new recording is 
started. 

For more information about assigning Keywords, recording special instructions and entering user-defined 
labels, refer to the User Manual delivered with the device. 

Note: The mandatory user input feature is only available with DPM 9400 and DPM 9450. 

Enable/disable DPM buttons 
Enable or disable various buttons on the DPM. The check mark next to a button name indicates that the 
button is currently enabled on the DPM. 

L button (DPM 9220, DPM 9250 and DPM 9360 only): 
EOL/P button (DPM 9400 and DPM 9450): If this option is disabled (no check mark), authors cannot assign 
the EOL (End-of-Letter) or Priority indication to their dictations. 

INS/OVR button: If this option is disabled, authors cannot switch between Insert mode and Overwrite mode 
when recording their dictations on the DPM. 

DEL button: If this option is disabled, authors cannot perform any delete operations on the DPM. 

Keyword Definition 

The definition of DPM Keywords enables authors to personalize their dictations via these predefined Keywords. 
The Keywords are a combination of a usage string and several content strings. This information is transferred to 
the DPM where the predefined Keywords become available to the authors.  

The authors can select from the predefined entries and assign them to their dictations. These entries are saved 
together with the dictation. They can, for example, be used by the transcriptionist for filtering the dictations. 

The DPM Download/Configuration program is delivered with the following default Keywords defined:  

Keyword 1 • 
Usage string: Author 
Content string: DPM 

Note: DPM 9250 and DPM 9350 enable you to define and assign two Keywords for every dictation file. DPM 
9400, DPM 9450, Philips 9750 and Philips 9850 enable you to define up to five Keywords. For DPM 9220 and 
DPM 9360, only one predefined Keyword is available which cannot be changed. The predefined usage string for 
the predefined DPM 9220 and DPM 9360 Keyword is Folder, the predefined content strings are Folder 1 to Folder 
10. 

Defining DPM Keywords 
The definition of a DPM Keyword involves the following steps: 

1. Definition of a Usage string. The maximum number of characters for each usage entry is 15.  

For example, the usage for Keyword 2 can be Subject, the usage for Keyword 3 Action. 

2. Definition of Content strings. Each Keyword usage can have up to 20 content entries; the maximum number 
of characters for each content entry is 15. 

For example, the content entries for the Keyword 2 usage (Subject) can be a selection of possible subject 
areas: Radiology, Surgery, etc. The content entries for the Keyword 3 usage (Action) can be a selection of 
possible follow up actions: None, Refer, etc. 

This information is transferred to the DPM where the author selects the subject name and action for each 
dictation. 
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Using the keyboard for moving between Keyword entries 
You can use the keys on your keyboard for moving between Keyword entries in the following way: 

Arrow keys: use the arrow keys to move up, down, right or left between entries. Moving between entries with 
the help of the arrow keys, highlights the entry. In order to start editing the entry, press the ENTER key. 

• 

• ENTER key: use this key to move from one Keyword entry to the next in a horizontal direction (left to right). 
For example, when you type a usage string for Keyword 1 and press ENTER, you automatically move to the 
usage field of Keyword 2. When typing the first content string for Keyword 1 and pressing ENTER, you 
automatically move to the first content field of Keyword 2. 

Transfer button 
Click this button to transfer the Keyword definitions immediately to DPM device which is connected. Other DPM 
settings you have made in the DPM Configuration dialog box are not transferred to the device with this action. 

Keyword Options (general) 

The Keyword Options page of the DPM Configuration dialog box enables users to make settings for linking 
sets of Keywords and scanning barcode information into keywords.  

Note: For information on Keyword input options using DPM 9450, see: Keyword Options (DPM 9450). 

Barcode into Keywords 
This setting enables you to scan barcode information into Keyword fields when using the DPM in combination with 
the DPM Barcode Scanner Module LFH 9284. 

The Barcode into Keywords setting is a mandatory setting. This means that when users create a new dictation 
file on the DPM and have the Barcode Module attached, they must scan in the barcode information before they 
can start to record the dictation. If no Barcode Module is attached to the DPM, the setting will be ignored. 

For more information on the DPM Barcode Scanner Module LFH 9284, refer to the documentation delivered with 
the product. 

Note: If you enable this setting, you will be prompted for barcode information for all Keywords you have defined 
on the Keyword Definition tab. For example, if you are using DPM 9400, DPM 9450, Philips 9750 or Philips 9850 
and only want to scan barcode information for Keyword 1, Keyword 2 and Keyword 3, do not define usage or 
content strings for Keyword 4 or Keyword 5. 

Linked Keywords 
The Linked Keywords setting enables you to transfer sets of Keyword strings to the DPM. These sets can then 
be selected on the DPM and assigned to a dictation file. A Keyword set is the sum of all content definitions in the 
same row. The name of the Keyword set is taken from the usage definition of Keyword 1; this name is also 
displayed on the DPM. The usage definitions of any other Keywords are ignored. 

Example 

The usage definition of Keyword 1 is patient; the content definitions of the Keyword 1 column are patient names, 
the content definitions of the Keyword 2 column are the patient IDs. A Keyword set thus combines a patient name 
with the patient ID: 

Keyword set 1 = Peter, 123 
Keyword set 2 = Steve, 456 
Keyword set 3 = Patricia, 789 

By selecting a Keyword set on the DPM, the user assigns all the included information to the dictation files and 
does not have to make multiple Keyword assignments. 

Note: The Linked Keywords setting and the Barcode into Keywords setting do not overrule each other. If the 
DPM has been configured with both settings, users will have to scan in the barcode information first (mandatory 
setting). To overwrite the barcode information with a Keyword set, they can enter the Keyword menu manually on 
the DPM and change the assignment. 

Note: The Linked Keywords setting and the Barcode into Keywords setting are not available with DPM 9220. 
The Barcode into Keywords setting is not available with DPM 9750. 

Keyword Options (DPM 9450) 

The Keyword Options page of the DPM Configuration dialog box enables you to define input options for 
Keywords. Unlike other DPM versions, when you are using the DPM 9450 you can make different settings for 
individual Keywords.   
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Note: For information on Keyword input options for other DPM versions, see: Keyword Options (general). 

You can assign the Keywords for the input options listed below. Activate the check boxes of those Keywords you 
want to set the selected input option for. If you do not want to set an input option make sure all check boxes are 
deactivated. 

Mandatory input 
This setting defines the Keyword selection as mandatory. This means that you have to provide the required 
Keyword input before you can start recording. 

Barcode scanning into 
This setting enables you to scan barcode information into Keyword fields when using the DPM in combination 
with the DPM Barcode Scanner Module LFH 9284.You have to provide the required input via barcode 
scanning; the DPM automatically displays the barcode scanning screen. 

For more information on the DPM Barcode Scanner Module LFH 9284, refer to the documentation delivered 
with the product. 

Note: If you enable barcode scanning into Keywords, the Linked Keywords option is not available. 

Type of voice command 
This settings defines how you input voice commands. 

Keyword: Enables you to use phrases for existing Keyword definitions. The maximum number of Keywords 
you can set is two. 

Alphanumeric: Enables you to spell out individual letters, numbers and some special characters.  

For information on using voice commands to assign Keywords, refer to the documentation delivered with the 
device. 

Voice command into 
This setting enables you to assign Keywords using voice commands. 

Note: If you enable voice commands into Keywords, the Linked Keywords option is not available. 

Note: The Barcode scanning into and the Voice command into selections are mutually exclusive. For 
example, if you have enabled Keyword 2 in the Barcode scanning into field, Keyword 2 is not listed in the 
Keyword Input: Voice Commands dialog box. 

Linked Keywords 
This setting enables you to transfer sets of Keyword strings to the DPM. These sets can then be selected on 
the DPM and assigned to a dictation file. A Keyword set is the sum of all content definitions in the same row. 
The name of the Keyword set is taken from the usage definition of Keyword 1; this name is also displayed on 
the DPM. The usage definitions of any other Keywords are ignored. See the "Keyword Options (general)" topic 
for an example of linked Keywords. 

Note: If you select the Linked Keywords check box, scanning barcode information into Keywords and using 
voice commands is not possible; the Select buttons for these input options are not available. 

Download Settings 

The Download Settings page of the DPM Configuration dialog box provides various options for device-specific 
settings for the file transfer between the DPM and the PC. The following options for defining the Download mode 
and the Download file type are available:  

Download mode 
After connecting 

Starts the file transfer automatically when the DPM is connected to the PC. 

After pressing DL/VC button 
Starts the file transfer when the DL/VC button on the DPM is pressed. 

Note: On DPM 9350 this is the DL button. On DPM 9400 this is the DL/S button. On DPM 9450 this is the 
DL/VC button. On Philips 9750 and Philips 9850 this is the DOWNLOAD button. 
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Download file type 
All files 

Downloads all files from the DPM to the PC. This is the default setting. 

EOL files 
Downloads all files with the EOL indication. 

File selection 
Displays the File Selection for Download dialog box which lists all files on the DPM. This dialog box enables 
you to select individual files for the file download. 

Files with Keyword 1 
Downloads all files with a specific Keyword assignment. This assignment matches the defined content string 
for Keyword 1 which can be typed into the field. 

For more information about defining DPM Keywords, see: Keyword Definition 

Delete files on the DPM after download is finished 
Deletes the downloaded dictation files on the DPM after they have been transferred to the PC. 

Protection 

Enabling the following option protects the DPM configuration:  

Protect device configuration 
This means that the settings for the DPM which have been made with the SpeechExec Pro Dictate program 
cannot be changed by users when they are working with the DPM. 

If the device protection is enabled, the following DPM menu entries cannot be accessed and changed: 

The menu entry for setting the date and time. • 

• 

• 

• 

• 

• 

• 

• 

• 

The menu entry for setting the Standard Play or Long Play mobile recording format. 

The menu entry for enabling and disabling the device beep. 

The menu entry for setting the microphone sensitivity. 

The menu entry for enabling and disabling voice-activated recording. 

The menu entry for enabling and disabling the backlit display function. 

The menu entry for changing the contrast setting. 

The menu entry for showing and hiding the remaining time. 

The menu entry for reformatting the memory card. 

Allowed characters 

The following characters and symbols can be used for defining Keyword entries (usage and content):  

A 

a 

B 

b 

C 

c 

D 

d 

E 

e 

F 

f 

G 

g 

H 

h 

I 

i 

J 

j 

K 

k 

L 

l 

M 

m 

N 

n 

O 

o 

P 

p 

Q 

q 

R 
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U 
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W 
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X 
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z 
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DPM Wizard 

DPM Configuration Wizard - overview 

Click  on the toolbar or go to the DPM menu and select DPM Wizard.  

The DPM Configuration Wizard assists novice users to configure the DPM. This wizard has the following pages: 

Download Mode and File Type: On this page, the mode for transferring files from the DPM to the PC is set. 
Users also define what type of files are transferred. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Recording Time: On this page, the DPM is set to either display the used-up recording time or the remaining 
recording time. 

Keyword Definition: On this page, users specify the Keywords for the DPM. 

DPM Buttons: On this page, various DPM buttons can be enabled and disabled. 

Settings for DPM: On this page, device-specific settings are made. 

Protection: On this page, users can specify that the DPM configuration will be set to read-only and cannot be 
changed on the device. 

Appearance: On this page, users define the screen layout of the DPM display they prefer for working with the 
DPM. 

Recording Format and Microphone Sensitivity: On this page, users define the audio format for recording 
dictations on the DPM. They also set the sensitivity level for audio input via the built-in microphone. 

DPM File Names: On this page, users define how the file names of DPM recordings are generated. 

Finish: On this page, users decide whether to transfer the settings they have just made to the DPM. If they 
click Cancel, the settings are not transferred. 

For information on working with DPM files, see: Downloading DPM files 

DPM Wizard: Download Mode and File Type 

On this page, you set the mode for transferring files from the DPM to the PC. You also define what type of files 
are transferred. Additionally, you can set whether files on the DPM should be deleted from the device once they 
have been downloaded.  

Download mode 
After connecting: The file transfer from the DPM to the PC is started automatically when you connect your 
DPM to the PC. 

• 

• 

• 

• 

• 

• 

After pressing DL/VC button: The file transfer from the DPM to the PC is started when you press the DL/VC 
button on the DPM. 

Note: On DPM 9350 this is the DL button. On DPM 9400 this is the DL/S.INSTR. button. On DPM 9450 this 
is the DL/VC button. On Philips 9750 and Philips 9850, this is the DOWNLOAD button. 

Download file type 
All files: All files on the DPM are transferred to the PC. 

EOL files: Only files with the EOL indication are transferred from the DPM to the PC. 

File selection: Displays the File Selection for Download dialog box. This dialog box lists all files on the 
DPM. Only the files you select in this dialog box are transferred from the DPM to the PC. 

Files with Keyword 1: Downloads all files with a specific Keyword assignment. This assignment matches the 
defined content string for Keyword 1 which can be typed into the field. 

For more information about defining DPM Keywords, see: Keyword Definition 
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Deleting files 
Delete files on the DPM after download is finished 

Deletes the downloaded dictation files on the DPM after they have been transferred to the PC. 

Note: These settings are only used if the option for automatically downloading files has been enabled on the 
Download page of the General Settings dialog box. 

DPM Wizard: Recording Time 

On this page, you define the type of recording time to be displayed on the DPM. You can choose to display the 
remaining recording time or the used-up recording time.  

 
Used time: This setting displays in HH:MM:SS the amount of time already recorded on the memory card. • 

• Remaining time: This setting displays in -HH:MM:SS the amount of time left for recording on the memory 
card.  

The minus symbol is used to distinguish between used time and remaining time.  

Note: The recording time is only displayed on the DPM if you have also chosen the Advanced display option, 
see: DPM Wizard: Appearance. The displayed time value also depends on the Standard Play or Long Play mobile 
setting, see: DPM Wizard: Recording Mode and Microphone Sensitivity. 

Note: This feature is not available with DPM 9220. 

DPM Wizard: Keyword Definition 

On this page, you specify the Keywords which can be selected on the DPM. Keywords enable authors to 
personalize their dictations via selecting their personal Keyword on the DPM.  

Keywords can also be used for workflow purposes and as the destination path if the automatic download 
functionality is enabled. 

The DPM Download/Configuration program is delivered with the following default Keywords defined:  

Keyword 1 • 
Usage string: Author 
Content string: DPM 

Example: Defining usage strings, each with 3 content strings, for Keyword 2 and Keyword 3 

1. For the Usage of Keyword 2, type: Subject 

2. For the Content of Keyword 2, type (use a separate row for each entry): Radiology, Surgery, Patient 

3. For the Usage of Keyword 3, type: Action 

4. For the Content of Keyword 3, type (use a separate row for each entry): None, Immediate, Refer 

The maximum number of characters for each usage and content entry is 15. Each Keyword can have 1 usage 
entry and 20 content entries. 

This information is transferred to the DPM where the author selects the subject names and actions for each 
dictation. 

Note: DPM 9250 and DPM 9350 enable you to define and assign two Keywords for every dictation file. DPM 
9400, DPM 9450, Philips 9750 and Philips 9850 enable to define up to five Keywords. For DPM 9220 and DPM 
9360 only one predefined Keyword is available which cannot be changed. The predefined usage string for the 
predefined DPM 9220 and DPM 9360 Keyword is Folder, the predefined content strings are Folder 1 to Folder 10. 
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DPM Wizard: DPM Buttons 

On this page, you can enable and disable various buttons on the DPM. The check mark next to a button name 
indicates that the button is currently enabled on the DPM.  

EOL button (DPM 9220 and DPM 9360  only) 
EOL/P button: If this option is disabled (no check mark), authors cannot assign the EOL (End-of-Letter) or 
Priority indication to their dictations. 

• 

• 

• 

INS/OVR button: If this option is disabled, authors cannot switch between Insert mode and Overwrite mode 
when recording their dictations on the DPM. 

DEL button: If this option is disabled, authors cannot perform any delete operations on the DPM. 

DPM Wizard: Settings for DPM 

On this page, you make device-specific settings for the DPM. To make a setting for the DPM, activate the check 
box next to it.  

AM/PM time format 
The DPM uses the AM/PM time format setting: AM 11:57 

Special instructions / Spoken instructions /Index 
Depending on the DPM which is connected, this setting defines that the DL/VC button on the DPM records a 
special instruction or an Index or a spoken instruction when it is pressed during recording. This is the DL/Index 
button on the DPM 9360 and the DL/S.INSTR. button on the DPM 9400.Pressing the DL/S button (DPM 9400) 
or DL/VC button (DPM 9450) during dictation creates an instruction file for the current dictation file. 

Note: The functionality for recording spoken instructions is only available with DPM 9400, DPM 9450, Philips 
9750 and Philips 9850. For more information about recording special instructions with these devices, refer to 
their User Manuals. 

When the DPM is connected to the PC and you press this button, the file transfer from the DPM to the PC is 
started. 

Device beep 
This setting defines that the DPM beeps when specific operations take place. For example, when playing back 
a dictation and the end of the file is reached. If the setting is not activated, the DPM is muted except for 
warnings. 

Voice-activated recording 
Voice-activated recording mode is a convenient feature for hands-free dictation. When voice-activated 
recording is enabled, the DPM is in Record Standby mode; recording will start automatically when the input 
level exceeds a certain threshold (this is usually when the author starts dictating). Recording stops 
automatically a few seconds after the author stops speaking and restarts automatically when the author starts 
speaking again. 

Record into one file only 
This setting defines that only one dictation sound file is created. 
Activating this option changes the behavior of the DPM. Any recording you make is stored in a single file, 
instead of separate files for different subjects; this behavior is similar to recording on a tape with an analog 
device. 

Record notification beep 
This setting defines that the DPM beeps when recording is possible. 
Activating this option means that you must wait until you hear a beep before you start recording; this behavior 
is similar to the behavior of standard voice mail machines. 
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DPM Wizard: Protection 

On this page, you specify that the DPM configuration is set to read-only and cannot be changed on the device.  

To enable the function for protecting the device configuration, activate the check box. The following DPM menu 
entries cannot be accessed and changed: 

The menu entry for setting the date and time. • 

• 

• 

• 

• 

• 

• 

• 

• 

The menu entry for setting the Standard Play or Long Play mobile recording format. 

The menu entry for enabling and disabling the device beep. 

The menu entry for setting the microphone sensitivity. 

The menu entry for enabling and disabling voice-activated recording. 

The menu entry for enabling and disabling the backlit display function. 

The menu entry for changing the contrast setting. 

The menu entry for showing and hiding the remaining time. 

The menu entry for reformatting the memory card. 

DPM Wizard: Appearance 

On this page, you define the screen layout of the DPM display.  

Standard display: The DPM display uses larger symbols. No status indication bar is displayed.  • 

 
Advanced display: The DPM display uses smaller symbols. Additionally, the status indication bar is 
displayed. The status indication bar provides visual feedback when a dictation, for example, is recorded or 
played back. The advanced display option shows more detailed information about the current dictation. This is 
also the default option with which the DPM is delivered. 

• 

 

DPM Wizard: Recording Format and Microphone Sensitivity 

On this page, you define what audio format is used for recording dictations on the DPM. You also set the 
sensitivity level for the audio input via the built-in microphone.  

Recording Format 
SP Standard Play (13.7 kbit/s): This recording format provides excellent audio quality. It is recommended 
when the dictation sound files are used, for example, for speech recognition. 

• 

• 

• 

• 

• 

With this format, about 312 minutes of recording time are available on a 32 MB memory card. 

LPm Long Play mobile (9.1 kbit/s): This recording format provides good audio quality. 

With this format, about 468 minutes of recording time are available on a 32 MB memory card. 

Microphone sensitivity 
Low: This setting is recommended when recording dictations in a noisy environment. 

Medium: This is the default setting and recommended when recording dictations in a normal environment. 

High: This setting is recommended when, for example, recording at a conference. 
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DPM Wizard: DPM File Names 

On this page, you define how the file names of DPM recordings are generated.  

File name 
This setting defines how DPM file names are created. 

Keyword 1: The file name creation is based on the predefined Keyword 1. • 

• 

• 

• 

Example 
Keyword 1 is Author (this is what has been defined as the Keyword 1 usage; see: Keyword Definition). The 
entries for the keyword usage are a selection of author's names: Jones, Singh, Watson. 
Author Watson selects the respective author name on the DPM. The DPM generates this file name: 
Wats001.dss; the first four characters of the author name are used for the file name. 

Prefix: The file name creation is based on the predefined prefix string. The prefix string may not have more 
than 4 characters. 

Example 
Author Watson defines the prefix string Memo. The DPM generates this file name: Memo001.dss 

Dictation number 
This setting defines the numbering sequence for dictation sound files on the DPM. 

Continue existing sequence: The current numbering sequence on the DPM remains unchanged. 

Example 
Author Watson selects this option to continue the current numbering sequence. There are already 15 files on 
the DPM, therefore the DPM continues the file numbering as follows: Wats016.dss, Wats017.dss, 
Wats018.dss, Wats019.dss and so on. 

Start new sequence: The number which is entered in the field will be used for creating a new numbering 
sequence after the settings have been transferred to the DPM. This means that the next new file, and from 
that point on all subsequent files, will use the new numbering sequence. 

Example 
Author Watson selects this option to create a new numbering sequence and types the following number into 
the field: 100 
The DPM generates file numbers as follows: Wats100.dss, Wats101.dss, Wats102.dss, Wats103.dss and so 
on. 

DPM Wizard: Completed 

On this page, you transfer the settings you have just made to the DPM by clicking the Finish button.  

If you click Finish, the DPM Configuration Wizard asks you to confirm that the settings are to be transferred to the 
DPM. 

If you click Cancel, the DPM Configuration Wizard is closed without transferring the settings to the device; the 
changes are discarded. 
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Filters 

Filters - overview 

You can filter your dictation list to display only specific information.  

Defining a filter 

Go to the View menu and select Filters or click on the toolbar. The Filters dialog box is displayed, here you 
can define a filter. 

Applying a filter 

Go to the View menu and select Apply Filter or click on the toolbar. Only dictations which fulfill the last filter 
criteria are listed.  

Click on the toolbar again to return to the unfiltered list. 

Filters dialog box 

The Filters dialog box enables you to define certain criteria for displaying only specific information in your 
dictation list. These criteria are also referred to as filter conditions.  

To display the Filters dialog box, go to the View menu and select Filters or click  on the toolbar. 

Buttons 
The Filters dialog box has the following buttons: 

New 
Creates a new row for defining a filter condition. 

Remove 
Deletes the selected filter condition. 

Clear 
Deletes all filter conditions. 

Load 
Loads a saved filter file (.fil file extension). 

Save 
Saves the current filter conditions to a filter file. 

Apply 
Applies the current filter conditions to your Worklist. 

Close 
Closes the Filters dialog box. 

Filter conditions 
A filter condition is made up of three parts: a column name, an operator and a value. 

Column name 
This is a list of all available column headings, e.g. Locked 

Operator 
This operator compares the column name and the value. There are the following operators, click an operator 
to view its definition and an example: 

 
Value 

This is where you define the specific information of the filter. For example an author's name or the name of a 
workflow phase. 
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Note: The Filter dialog box does not recognize the dictation state names. To filter for a state name enter the 
following number in the Value column: 

<recording in progress> - 0 
<recording suspended> - 1 
<transcription pending> - 2, 
<transcription in progress> - 3 
<transcription suspended> - 4 
<transcription finished> - 5 

Logical operators 
To combine filter conditions, you can select the following logical operators: 

AND 
This means that the displayed filter results fulfill all specified filter conditions. Click here for an example. 

OR 
This means that the displayed filter results fulfill at least one of the specified filter conditions. Click here for an 
example. 

Defining custom filters 

To define a custom filter, do the following:  

1. Click New. 

2. Select the Column name property and the Operator comparison algorithm, and type the specific information 
you are looking for into the Value column. 

Example 
Column name - select: Revision author 
Operator - select: LIKE 
Value - type: zela* 
(click here to see a screenshot) 

3. Click Apply to filter the list accordingly. 

Note: If you use the LIKE operator, you have to use the asterisk character (*) as a placeholder in combination 
with your search term.  

Example 
Author LIKE *zela 
Result: Any author names ending with zela. 

Author LIKE zela* 
Result: Any author names starting with zela. 

Author LIKE *zela* 
Result: Any author names with zela in them. 

Defining multiple filter conditions  
Every time you click the New button, a new row is added to the list for defining a filter condition. By specifying the 
type of Logical operator you define how these filter conditions relate to each other. 

Example 
Condition 1: Revision author LIKE zela* 
Condition 2: Author LIKE zela* 
Condition 3: Created >= 5/25 
Logical operator: AND 
(click here to see a screenshot) 

Result 
When you click the Apply button, the list only displays dictations created by or for any authors whose 
names start with zela. Additionally, these dictations were created on May 25 and later. 

Note: If you specified the OR operator, the list only displays dictations created by authors whose names start 
with zela or dictations created for these authors or dictations created on May 25 and later. 

The date and time format which is displayed and which you can enter depends on the regional settings of your 
Windows operating system (Start menu, Settings, Control Panel, Regional Options). 
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Saving and loading filters  

The custom filters you have created can be saved and loaded again later so that you can reapply them or edit 
them.  

Saving filters 
To save a custom filter, do the following: 

1. In the Filters dialog box, define the custom filter including filter conditions and logical operator. 

2. Click Save. The corresponding dialog box is displayed. 

3. Specify the location where you want to store the filter and type the filter name. The file extension is .fil. 

4. Click Save. 

Loading filters 
To load a custom filter, do the following: 

1. In the Filters dialog box, click Load. The corresponding dialog box is displayed. 

2. Browse for the location where you have stored your custom filters. 

3. Select a filter file (.fil file extension) and click Open. 

The predefined filter conditions of that filter are displayed in the Filters dialog box. 
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Speech Recognition 

Speech recognition - overview 

SpeechExec can connect to your speech recognition system automatically, if you have one installed. The 
following speech recognition systems are supported:  

Philips SpeechMagic 5.11 Service Pack 3 (and higher) • 

• Scansoft Dragon NaturallySpeaking 7.0 (and higher) 

Note: The SpeechExec installation process does not install either of these speech recognition systems. 

If you have a speech recognition system installed, the Submit for Speech Recognition option is available in the 
File menu and on the toolbar: . If you have both speech recognition systems installed, the Speech 
Recognition Program dialog box is displayed when you select this option. You must specify which system is to 
be used for recognizing SpeechExec dictations. 

Both authors and transcriptionists can submit dictations for speech recognition. Dictations can be submitted for 
speech recognition from any folder in your tree view and with any dictation state, unless the state is <In 
progress>. You can submit more than one dictation at a time (CTRL and SHIFT keys).  

Dictation files which have been submitted for speech recognition remain in their original SpeechExec folder. 
Encrypted files which are submitted for speech recognition are decrypted to the SpeechExec Temp folder. The 
text document created by the speech recognition system remains within the speech recognition system. 

Speech recognition is not supported for dictations with the following recording formats: 

.wav files with a sampling rate of less than 11kHz (e.g. 8kHz files are not supported). • 

• .dss files with the Long Play or Long Play mobile format. 

SpeechMagic 

If you have Philips SpeechMagic installed you can send SpeechExec dictations to the SpeechMagic system for 
speech recognition.  

For detailed information on working with SpeechMagic, refer to the SpeechMagic Online Help. 

Selecting a ConText and user 
When you send dictations for speech recognition, the Select ConText and User dialog box is displayed with the 
following fields and buttons: 

User name 
Your SpeechMagic user name. 

ConTexts button 
Lists the ConTexts installed for the selected user. 

ConTexts section 
Select the ConText you want to use. 

Submit 
When you click this button, the selected files are transferred to the SpeechMagic system for recognition using 
the selected ConText. 

Cancel 
If you click this button, the dialog box will be closed without submitting the selected dictations. 

Recording format and input channel 
It is sometimes necessary to convert the recording format of the SpeechExec dictations to Philips CELP 16kHz 
(with microphone input channel), when they are submitted to SpeechMagic. The following formats are 
automatically converted: .wma, .MP3, .wav, .dss files.  

Converted dictation files are saved to the SpeechExec Temp folder (the original file remains in its original folder). 
Any other files associated with the dictations, such as special instruction files, are not converted. 
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The recognition system 
When the files have been converted they are sent to the speech recognition system. 

If you have selected more than one dictation, the dictations are queued and handled by the SpeechMagic system 
as separate jobs. When all submitted dictations are successfully queued within the SpeechMagic system the 
converted files in the SpeechExec Temp folder are deleted; the focus returns to your SpeechExec Worklist. 

SpeechExec dictations will be included in SpeechMagic ConText Adaptation and Acoustic Adaptation. 

Special instruction files are not submitted to SpeechMagic. If you want to listen to a special instruction file you 
must do this via your SpeechExec Worklist. 

Recognition and correction 
Recognition is done within the SpeechMagic system. Information about recognition is not provided in 
SpeechExec. If you want to correct these dictations you must start the SpeechMagic Correction Manager. 

Dragon NaturallySpeaking 

If you have Scansoft Dragon NaturallySpeaking installed you can send SpeechExec dictations to the Dragon 
system for speech recognition.   

For detailed information on working with Dragon NaturallySpeaking, refer to the Dragon NaturallySpeaking Help. 

Recording format 
When dictation sound files and their associated special instruction files are sent for speech recognition to Dragon 
NaturallySpeaking the recording format is converted to .wav PCM 16Bit Mono with the same sampling rate as the 
original file (e.g. 11 kHz to 44 kHz). The following formats are automatically converted: .wma, .MP3, .wav, .dss 
files. The progress of the conversion is displayed. 

Converted dictation files are saved to the SpeechExec Temp folder (the original file remains in its original folder). 

The recognition system 
When the files have been converted they are sent to the speech recognition system.  

If you have selected more than one dictation, the dictations are queued and handled by the Dragon system as 
separate jobs. Spoken instructions are recognized as part of the dictation sound file. Special instruction files are 
queued in front of the dictation sound file they are associated with. 

Once you have selected your Dragon user name and vocabulary, and made settings for transcription, recognition 
starts. 

When the files have been converted they are sent to the speech recognition system. 

Recognition and correction 
Recognition is done within the Dragon system. Information about recognition is not provided in SpeechExec. The 
specified word processing window is opened and the dictations are recognized online. The recognized text starts 
with the special instructions. 

The recognized text of spoken and special instructions must be deleted manually during correction. When 
correction is finished the final document can be saved and printed out within the Dragon system. 

When correction is finished the converted files in the SpeechExec Temp folder are deleted. The dictations which 
were sent for speech recognition are still selected; you can delete or move them if necessary. 
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Submitting dictations for speech recognition via SpeechMagic 

If you have SpeechMagic installed, do the following:  

1. In your Worklist select the dictations you want to send for speech recognition. 

2. Go to the File menu and select Submit for Speech Recognition or click  on the toolbar. The Submit for 
Speech Recognition dialog box is displayed listing the dictations. 

3. Click Submit. The dictations' recording format is converted (if necessary) and the Select ConText and User 
dialog box is displayed. 

4. Type in your SpeechMagic user name and click ConTexts to list the ConTexts (with input channel) that are 
assigned to you. 

5. Select the ConText you want to use and click OK. 

The dictations are queued in the SpeechMagic system and you can continue working with SpeechExec. 

Submitting dictations for speech recognition via Dragon NaturallySpeaking 

If you have Dragon NaturallySpeaking installed, do the following: 

1. In your Worklist select the dictations you want to send for speech recognition. 

2. Go to the File menu and select Submit for Speech Recognition or click  on the toolbar. The Submit for 
Speech Recognition dialog box is displayed listing the dictations. 

3. Click Submit. The dictations' recording format is converted and the Open User dialog box is displayed. 

4. Select your Dragon user name. The speech recognition system loads your user profile and displays the 
Transcription Options dialog box. 

Note: If the Dragon system is running in the background you do not have to select your user name. 

5. Make your settings and click Transcribe. Recognition starts. 

The dictations are queued in the Dragon system and you can continue working with SpeechExec. 
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Troubleshooting 

Troubleshooting - overview 

This book identifies problems you might encounter and suggests actions to counter the problems. Follow the link 
that best describes your problem.  

If you need help with your network, see: 

Network connection lost • 

• 

• 

• 

Program stops responding 

Installing to a network folder 

If you need help with hardware, see: 

USB SpeechMike 

If you encounter any other problems, visit our web site: http://www.philips.com/speechrecognition 

Network connection lost  

Problem 
The network connection is lost while the Recorder module is being used. 

1. Working locally 
2. Working over the network 

Situation 1 
The dictation being worked on is saved in the temp folder. 

Solution 1 
No immediate action is required, no information is lost and work can continue. When the dictation is finished and 
the target network folder is not available then the dictation is moved to the Local Work folder. Synchronizing the 
data with the network is not possible until the network connection is restored. 

When the network is available again no message will be displayed, synchronisation must be done manually. To 
synchronize the data saved locally with the network folders go to the File menu and select Synchronize. 

Situation 2 
The dictation being worked on is saved in a network folder. 

Solution 2 
This dictation is suspended and no longer available, but no information is lost. To continue working create a new 
dictation locally. 

When the network is available again you can synchronize the data saved locally with the network folders (go to 
the File menu and select Synchronize). You can then open the dictation, suspended when the network 
connection was lost, and finish recording it. 

If you did not create any new dictations locally while the network connection was unavailable, when the program 
is restarted a message is automatically displayed asking if you want to open the dictation, suspended when the 
network connection was lost, and finish recording it. 

Remarks 
If this situation arises an error message is displayed in the Recorder module. Select one of the following options: 

Shut down the Recorder module and return to the Worklist module. • 

• Continue to work in the Recorder module. If you select this option the error message is displayed periodically 
as long as the network connection is not available. 

88 



SpeechExec Pro Transcribe 

Program stops responding 

Problem 
The program stops responding while you are recording a dictation. 

1. SpeechExec Pro Transcribe stops responding 
2. SpeechExec Player stops responding 

Situation 1 
The SpeechExec Pro Transcribe module stops responding while you are recording a dictation. 

Solution 1 
Restart the program from the Start menu, Programs, SpeechExec Pro Transcribe.  

A message is displayed asking if you want to continue working on the dictation. If you decide not to continue 
working on this dictation, the dictation is moved to your Suspended folder with the state <Transcription 
suspended>. 

Situation 2 
The SpeechExec Player module stops responding while you are recording a dictation. 

Solution 2 
In the Worklist module go to the folder where the dictation is stored and select it. You can continue working as 
normal. 

Remarks 
No information is lost. The Worklist module will restore your dictation with all data and properties intact. 

Installing to a network folder 

Problem 
SpeechExec works when installed locally but throws a Security Exception when installed or moved to a network 
folder. 

Situation 
.NET programs use code access security (CAS). CAS is different from traditional security systems in that it 
assigns trust to the software program rather than users.  

When a program is installed locally the program is run from your local PC, this is the My Computer zone of the 
PC. When a program is installed centrally the program is run from a server, or a shared network drive mapped on 
your PC, this is the Local Intranet zone.  

By default any program that is run from the My Computer zone will get a permission set of full trust (unrestricted 
permission to do anything feasible). However, by default, there is a more restrictive permission set given to Local 
Intranet assemblies.  

Solution 
There are two ways to make SpeechExec work from the Local Intranet zone: 

Modify the security policy to fully trust the SpeechExec mapped drive (this option is recommended). • 

• Modify the security policy to fully trust the Local Intranet zone (this option is not recommended). 
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Fully trust SpeechExec mapped drive 
To modify the security policy to fully trust the SpeechExec mapped drive, do the following: 

1. Go to the Start menu, Control Panel, Administrative Tools and double-click Microsoft .NET Framework 
1.1 Configuration. The corresponding dialog box is displayed. 

2. Expand Runtime Security Policy, Machine, Code Groups. 

3. Right-click All_Code and select New. The corresponding wizard is displayed. Fill in the pages as follows: 
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Note: U = the SpeechExec mapped drive letter.  

 
4. Click Next and Finish to save your settings. 

Note: You can also run the Microsoft .NET Framework Configuration tool using the command line parameter: 
mscorcfg.msc.  
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Fully trust all Intranet assemblies 
To modify the policy to allow full trust for all Intranet assemblies, do the following:  

1. Go to the Start menu, Control Panel, Administrative Tools and double-click Microsoft .NET Framework 
1.1 Configuration. The corresponding dialog box is displayed. 

2. Expand Runtime Security Policy, Machine, Code Groups, All_Code.  

3. Right-click LocalIntranet_Zone and select Properties. The corresponding dialog box is displayed.  

4. Make the following setting: 

 
5. Click Apply to save your setting. 

Remarks 
A good reference CAS can be found here:  

http://msdn.microsoft.com/msdnmag/issues/01/02/CAS/default.aspx 
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USB SpeechMike 

Problem 
Your USB SpeechMike is not working after connection to the USB port. 

Situation 
The PC's USB port does not meet the required specifications.  

Some PC providers limit the output power of USB ports to 100mA (milliamps). These USB ports are called bus-
powered USB ports. 

Important: It is not the case that any USB device can be connected to any USB port. 

SpeechMike requires a self-powered USB port which provides 500mA. When connected to a bus-powered USB 
port the PC will cut the connection to the SpeechMike. 

Solution 
Connect the SpeechMike to a self-powered USB port providing 500mA of power on the PC. It will always have 
enough power to function. 

If your PC does not provide a self-powered USB port please connect your SpeechMike to an active (self-powered) 
USB hub. 

Remarks 
Self-powered USB ports draw their power from the electrical outlet as opposed to the USB bus. This means that 
self-powered USB ports have a significant advantage over bus-powered USB ports. 
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Appendix 

Command line parameters 

The SpeechExec program supports the following command line parameters:  

/h 
Hidden start: The SpeechExec program is started but no program window is opened; the program icon is 
displayed in the status notification area of the Windows task bar:  

/p 
Protect DPM configuration: The DPM configuration settings cannot be changed by the users. 
This means that any settings in the DPM Download/Configuration program are read-only information for the 
users. The users can view the settings but they cannot make any changes. 

Note: This parameter is different from enabling the Protect device configuration option in the DPM 
Configuration dialog box. This option prevents users from changing the device-specific settings on the DPM. 

/v 
Protect user interface view: The following settings cannot be changed by the user: 

Tree view: The user cannot create or delete folders. • 
• 
• 
• 

Columns: The user cannot add or remove columns from the Worklist. 
Sort order: The user cannot change the sort order (ascending/descending) of the columns in the Worklist. 
Filter: The user cannot apply a personalized filter to the Worklist. 

Note: This parameter is only applied when the program is started. If the program is already running it is not 
applied until the program has been closed down and restarted. 
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